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The 17 goals of the UN

The "Agenda 2030 for Sustainable Development" is a global United Nations action plan for people, the planet and
prosperity adopted by the UN General Assembly in September 2015. With Agenda 2030, the member states of
the United Nations have developed a roadmap for the "transformation of the world for the better" in the sense of a
sustainable transformation of society, economy and environment by the year 2030. Agenda 2030 includes 17
global goals divided into 169 subgoals (cf. indicators of the UN sustainability goals?).

The 17 Sustainable Development Goals (SDGS) are political objectives of the United Nations (UN) that are in-
tended to secure sustainable development at the economic, social and ecological levels (see Sustainable Devel-
opment Goals?). The goals were designed in line with the development process of the Millennium Development
Goals (MDGs) and entered into force on 1 January 2016 with a duration of 15 years (until 2030). In contrast to the
MDGs, which applied in particular to developing countries, the SDGs apply to all states. If you want to get an
overview of the sustainability goals, watch the UN-Video?2.
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Exercise:

In the exercise, you will deal with one of more than 200 indicators on the 169 subgoals. Please note that not all
indicators have comprehensive data (we would like to have data on all countries over longer periods for evalua-
tion purposes). A comprehensive description of all indicators can be found under List of indicators*. The path to

L https://unstats.un.org/sdgs/indicators/indicators-list/

2 https://www.un.org/sustainabledevelopment/sustainable-development-goals/
3 https://www.youtube.com/watch?v=0XTBYMfZyrM&feature=youtu.be

4 https://unstats.un.org/sdgs/indicators/indicators-list/
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download the freely available original data is Database®. Before you start editing, please read the meta infor- \
mation for the selected indicator carefully in order to assess whether a meaningful question can be edited and
evaluated.

Regardless of the selected processing level (Advanced, Basic or Click-by-Click), the following statements could
be worked out in the document, for example:

= |n which direction does the selected indicator move worldwide?

= Which country has the greatest progress/regression relative to the indicator to be evaluated in the period un-
der consideration?

= Which region/continent on earth presents itself as problematic/progressive?
= Compare some countries with respect to the indicator to be evaluated in the period under consideration.
Try to establish connections with the global political situation or other knowledge about the topic.

1. Try to understand and penetrate the topic on the basis of the literature. Take a very close look at the metadata
description (thematic classification, methodology and validation, data quality ...) of the selected indicator so that
you can specify your question precisely and interpret the results obtained correctly.

2. Design a workflow for your data processing (tabular evaluation, GIS evaluation).
3. Create a structure of your document (no process description or work report, style of a scientific paper).

4. Evaluate your data and prepare it, both the table data in the form of measures and diagrams, and the geoinfor-
mation in the form of thematic maps. For this purpose you link the attribute data with suitable spatial data of the
national borders, for which we need a common key in both data sets (a mostly numerical country code such as
ISO 3166-1, compare e.g. https://www.laenderdaten.info/laendercodes.php).
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Different country codes

5. At the end we create thematic maps with all necessary information in DIN A 4 format.

Document delivery: Prepare a maximum of ten pages (text, diagrams, maps) on the thematic context (topic, UN
goal, significance of the indicator, critical examination of the data situation, own calculation and interpretation of
the results) in a document with common Office and GIS programs (Word, Excel, OpenOffice, LibreOffice, ArcGIS,
QGIS etc.). Your elaboration should contain at least 1 diagram and at least 1 thematic map. Briefly introduce the
chosen topic and interpret the result. Please indicate the sources used (including data sources) in a correct and
comprehensible manner, as is customary for scientific research.

Note: In this click-by-click instructions we present the processing of attribute data with Excel (commercial software,
here Excel 2016) and LibreOfficeCalc (open software) in parallel and geo processing with ArcGIS Desktop (com-
mercial software, here ArcMap 10.5.1) and QGIS (open software). Thus the user has in any case the chance to

> https://unstats.un.org/sdgs/indicators/database/
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perform the processing with open software, or otherwise, depending on availability, to use common commerci}
software in his working environment.

Problem statement

. Evalua- Visualisa- Interpreta-
tion tion tion

Data Data pre-

search paration N

Select a meaningful statistical data set on one of the SDG topics (e.g. poverty, hunger, .. peace, partnerships)
with temporal statements (time series) related to the national aggregation level. This dataset should be com-
pletely downloadable (e.g. as ASCII, csv, xIs) and can therefore be evaluated on the desktop with the standard
tools known to you. Do not use a completely prepared indicator, but a raw data set.

Topic here: Global trend in renewable energies

For this example, the global trend in renewable energies will be examined. In other words, the exact extent to
which the share of renewable energies in total energy consumption changed between 2000 and 2016. Indica-
tor 7.2.1 - Renewable energy share in the total final energy consumption (%)" (indicator EG_FEC_RNEW) is
selected for this purpose. This is an estimated percentage, based on national data, of the share of final con-
sumption of energy derived from renewable resources in relation to total consumption.

In addition to looking at the situation worldwide (spatially and temporally), we would like to make a comparison
of countries. For this purpose, we look at one country on each continent, for which we choose the example:

Europe: Germany Australia: Australia North America: Costa Rica
South America: Ecuador Africa: Algeria Asia: Vietnam
Data search

Problem Data pre- . Evalua- Visualisa- Interpreta-
] Maodeling . . .
statement paration tion tion tion

UN records

The first step is to locate the relevant records; this can be done by navigating the UN website, or (often faster) by
making a search using a search engine. Finally, the records can be found at; https://unstats.un.org/sdgs/indica-
tors/database/

un sustainable development goals data download _!, Q,

Alle News Videos Bilder Shopping Mehr Einstellungen Tools

Ungeféhr 26.400.000 Ergebnisse (0,57 Sekunden)

Global SDG Indicators Database - UNSD
https://unstats.un.org/sdgs/indicators/database/ ¥ Diese Seite (ibersetzen

... to data compiled through the UN System in preparation for the Secretary-General's annual report on
"Progress towards the Sustainable Development Goals".

Data search for SDG indicators

At https://unstats.un.org/sdgs/indicators/database/, search for a data set on one of the 17 sustainability goals and
consider what you want to (or can) present in the end, do not forget the time series reference. An overview of all
UN indicators can be found in the document "Global indicator framework for the Sustainable Development Goals
and targets of the 2030 Agenda for Sustainable Development". The metadata (i.e. what the indicator says, how it
is collected, etc.) can be found in the Metadata repository. You should definitely take a look at this in order to
adapt your evaluations accordingly and critically question them.

Agrar- und Umweltwissenschaftliche Fakultat e Justus-von-Liebig-Weg 6 ® 18059 Rostock



https://unstats.un.org/sdgs/indicators/database/
https://unstats.un.org/sdgs/indicators/database/
https://unstats.un.org/sdgs/indicators/database/
https://unstats.un.org/sdgs/indicators/indicators-list/
https://unstats.un.org/sdgs/indicators/indicators-list/
https://unstats.un.org/sdgs/metadata/

f

Professorship for Geodesy
Traditio et Innovatio and GeOinformatiCS

Universitat
Rostock

Topic here: Global trend in renewable energies

Consumption of renewable energy includes consumption of energy from water, solid biofuels, wind, solar, liquid
biofuels, biogas, geothermal energy, seawater and waste. Total final energy consumption is calculated from na-
tional reports and statistics as total final consumption minus non-energy consumption. This indicator is based on
comprehensive, annually updated energy statistics on supply and demand for all energy sources - statistics that
should be used to establish a national energy balance and thus have a fairly high reliability. Internationally agreed
methods for energy statistics are described in the "International Recommendations on Energy Statistics" (IRES)
adopted by the United Nations Statistical Commission and available at the following address: IRES®. The IRES
time series dates back to 1990.

Last updated on Monday, fuly 23, 2018 { see tistory) IR IRREIH S
Data Series (selected 1 of 356) Geagraphic Areas (selected 255 of 255) ‘Years 2005 to 2015 2,772 observations

= Select from all series
Search and select indicators @ Type here. m

= all

2 ) GOAL 4 Ensure inclusive and equitable quality education and promeote lifelong learning opportunities for all
B 0 GOAL S Achieve gender equality and empower all women and girls

) GOAL 6 Ensure availability and sustainable management of water and sanitation for all
8= GOAL 7 Ensure access to affordable, reliable, sustainable and modern energy for all
TARGET 7.1 By 2030, ensure universal access to affordable, reliable and modern energy services
B ¥ TARGET 7.2 By 2030, increase substantially the share of renewable energy in the global energy mix
= # INDICATOR 7.2.1 Renewable energy share in the total final energy consumption

# Renewable energy share in the total final energy consumption (%) EG_FEC_RNEW
TARGET 7.3 By 2030, double the global rate of improvement in energy efficiency
0 ) GOAL 8 Promate sustained, inclusive and sustainable economic growth, full and preductive employment and decent waork for all
@ (1 GOAL 9 Build resilient infrastructure, promote inclusive and sustainable industrialization and foster innovation

B2 ) GOAL 10 Reduce inequality within and among countries

SDG Goal 7

Under Show table you can find a preview of the data and under Years you can select the period. At the beginning
of August 2019, the data for the selected indicator cover a total of 4,624 observations for the period 2000 to 2016.
It is important that these factual data can later be linked to the spatial data, i.e. the national borders (the relational
operator JOIN), via a unique key. This is, as we will explain later, the column geoAreaCode, hamely a numeric
country code.

In order to download the correct data set, it is necessary to click on the Years 2000 to 2016 tab. Then click on
Show table to download the dataset as an Excel spreadsheet at the end of the page. If the data set meets your
requirements, click on Download.

We download the dataset in csv format, even if here some additional steps are necessary, because the data are
different in this case (rows and columns transposed, so that a pivotation is necessary). Excel format would also
be possible. In both cases, you have to check the cells for usable data types, which we describe for csv.

® https://unstats.un.org/unsd/energy/ires/
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Indicator 7.2.1, Series: Renewable energy share in the total final energy consumption (%) EG_FEC_RNEW \
Country Units 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014
Afghanistan PERCENT 40.86 ¢ 37.14E 33.86F 21.34F 17.81E 14.84E 11.48E 13.97F 16.33E 19.31E
Albania PERCENT 36.87 31.71E 32.10F 3591°F 37.22F 37.12¢ 35.96 ¢ 40.05F 41.29F 38.69 ¢
Algeria PERCENT 0.58E 041E 041E 030F 031E 026F 0.18E 0.19E 0.14E 007F
American Samoa PERCENT 0.00% 0.00% 0.00°¢ 0.00% 0.00% 0.00°¢ 0.00% 0.70% 070°¢ 070E
Andorra PERCENT 16.90 17.49F 16.94F 17.42°¢ 17.52F 19.09F 18.97°¢ 19.20F 19.56F 19.89
Angola PERCENT 70.95¢ 65.02F 61.60F 58.11E 55.75E 54.19E 52.72F 52.25€ 50.69F 50.80 ¢
Anguilla PERCENT 0.14F 0128 0128 0.12F 0128 0.12¢ 0.13¢ 0.13E 0.14¢ 0.13¢

»
1 2 3 4 5 > >

SDG-Indikator 7.2.1 Renewable Energy share in the total finakl energy consumption
Table structure

The structure of the SDG tables is largely homogeneous. The only difference is the technical content of the indi-
cators. In the following the information important for your later elaboration is presented and explained:

= |ndicator

= Series Description
=  GeoAreaCode

=  GeoAreaName

=  TimePeriod

= Value
= Units
= Source

Indicator: The SDG data are subject to a strict structure. It is divided into Goal, Target, Indicator, where Goal is
the macro level, Target is the meso level and Indicator is the micro level. The indicator thus names the exact des-
ignation of the affiliation of the data to the UN targets. This information is very valuable because not all the data in
the table comes from the indicator you have selected. It is advisable to process the metadata of each listed indi-
cator, as they have been selected to match your indicator. This may offer new interfaces.

Series Description gives a short description or the name of the previously specified indicator.

GeoAreaCode is a country ID selected by the UN. However, these do not correspond to the standardized country
IDs. Nevertheless, this ID should be used for possible links later.

GeoAreaName contains the country names. This column could also be used for the join of the table with the
country shape file in GIS editing, but different spelling of the names is a hindrance here.

TimePeriod indicates the year the data is viewed. In the metadata, the entire observation period can also be
read.

Value lists the values that you analyze and with which you will calculate. Pay particular attention to decimal num-
bers or possible 1000 digits for larger numbers. It should also be mentioned that the values are often subdivided
again. This subdivision is indicated in one or more further columns. For example, the indicator 3.c.1 "Health
worker density, by type of occupation” divides into the medical specialties in the column "Type of occupation”.

Units indicate the unit of the numerical values (value) and are therefore an important component of their later
analysis.

Source indicates the primary source of the indicators. You should pay special attention to these during your re-
search. Using this information, try to relate the results of your analysis to the political or economic situation in the
areas you select.

The metadata (what the indicator says, how it is collected, etc.) can be found in the Metadata repository’. You
should definitely take a look at this in order to adapt your evaluations accordingly and to critically question them.

7 https://unstats.un.org/sdgs/metadata/
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The metadata provides information on how your data was structured and collected. Only with this information you\
will be able to interpret your data correctly. In addition, information on the period under review and the sources of
the studies is also provided here. These will be particularly important in your later report.

Each UN data set can have a slightly different structure, which is why the next step shows only one example of
an indicator. Here it is important for you to get an overview of the data yourself and to define a question. Write it
down in a structured way and search for statistical evaluation methods. Think about what you want (or are able)
to display at the end, do not forget the time reference in addition to the spatial reference.

Country borders

Next, a data set with the country borders is required. On the Open Data Website Natural Earth® you can find
some matching vector data sets. Natural Earth is a publicly accessible map dataset that is available at scales of
1:10,000,000, 1:50,000,000, and 1:110,000,000 and does not require permission for use. However, you are wel-

come to quote the data source, e.g. in the form "Made with Natural Earth. Free vector and raster map data @ nat-
uralearthdata.com.”

(i C' | @ Sicher https://www.naturalearthdata.com/downlo

NAlUldl CANl ] g

Home Features Downloads Blog Forums Corrections Ab
« Downloads

1:50m Cultural Vectors

Download all 5om eultural themes | (7.50 MB) version 4.1.0

Files have been downloaded 273,533 times,

Admin 0 - Countries

——  There are 247 countries in the world. Greenland as separate
from Demmark. Most users will want this file instead of sovereign
states.

 —
p h 56,04 KB) version 4.1.0
Download without boundary lakes'| (772.6 KB) version 4.1.0

About | Issues | Version History »

Natural Earth Entry

Under the Downloads tab, select vector data on the subject of cultural vectors on a scale of 1:50 000 000 and
download the Shapefile Admin 0 - Countries.

Data preparation

Data . Evalua- Visualisa- Interpreta-
search ‘ Modeling tion tion tion
Data organization

In order to work efficiently on a project, it is very important to organize it properly. This starts with the folder struc-
ture on your computer. Create a folder (right click on the location => New => Folder). In this case it could be
named "SDG". Make sure that you do not use any umlauts, special characters or spaces in the name. In some
cases these can cause problems for the individual software types. Especially when processing with ArcGIS, error
messages may occur. The length of the file path should also be kept as short as possible. Therefore in this exam-
ple "Sustainable Development Goals" was abbreviated as "SDG".

In the next step some subfolders can be created. For this example you could create the following structure:

8 http://www.naturalearthdata.com/
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= (1 Basic data: In the folder "01_Basic data" only the basic data of the project are saved. These will not bex
changed later.

= (02_Analysis: The partial steps as well as the results of the analysis are stored in the corresponding folder
"02_Analysis". When saving the substeps, make sure that they are properly named. Depending on the length
of the project, you can select the current date as the name supplement here (for example
SDG_10122018.xls).

= 03_Sources: The folder "03_Sources" contains, as the name already says, the sources of your project. Al-
ways save them directly in this folder, which can save you a lot of work when writing the document.

= 04_Dispense: You can save the final files in the folder "04_Dispense". This way you have an overview of all
important documents for the later upload and do not forget to upload any.

Excursus csv files: csv files are text files that can be read in software such as the Editor or Notepad++. In a ta-
ble-like structure, the columns are separated by a comma, space or semicolon. The format is supported by many
software products and is therefore often used as an exchange format. You can learn more about this in the Data
Formats tutorial®.

UN data with Excel 2016

This section uses the commercial program Excel 2016. If this program is not available to you, or you prefer to
work with Free/Open Software for other reasons, you can switch to the section Data Preparation with LibreOffice
Calc.

Import data into Excel

Before the UN dataset can be processed with a GIS, it must first be converted into an appropriate form. Open Ex-
cel and import the CSV file with the sustainability goals. Importing CSV files in Excel 2016 works as follows:

Open Excel. Click Data => Retrieve External Data => From Text and select the CSV file containing the UN data.

FILE HOME INSERT PAGE LAYOUT FORMULAS REVIEW
B | =t [2] Connections al [Z1A| Y = [
— I S N Zv |A|Z] l |:_5 =t E.g |
Get External Refresh z| Sort Filter Text to
Data ~ All~ t 5 Yo Advanced  Columns S5 |
Connections Sort & Filter
M M ™ =
sy & E
From From From Other Existing £ : G
Access Web =xt  Sources~  Connections k

Get External Data

Input of CSV data

Next, you need to specify the conditions under which the CSV file should be imported. At steps 1 and 2, select
the settings as shown in the images. In step 3 you can change the data format of the columns and exclude indi-
vidual columns from the import. Both can be changed afterwards. The important thing with step 3 is that you im-
port the column with the numerical values first as text, since Excel has the habit of interpreting numbers with peri-
ods as decimal separators as dates.

The indicator or goal designations can be imported as text, since they are not values with which to calculate. In
case of a declaration as a number, Excel would also often output it as a date, so that the indicators would no
longer be readable.

= Goal (Text)

= Target (Text)

= Indicator (Text)

= GeoAreaNames (Text)

= geoAreaCode (Standard)
= Value_xxxx (Standard)

% https://learn.opengeoedu.de/tutorials#tutorial-datenformate
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The value column(s), i.e. the column in which our energy values are located, must be declared as standard (i.ﬁ
as a number). However, since a decimal value is often present, a character must also be selected for this. This
can be set under the button "More". For the settings a new window opens, where on the one hand the "1000 dig-
its" and on the other hand the decimal digits are listed. Since the SDG data are international, the decimal places
are marked with a dot. The 1000 digits, on the other hand, are marked with a comma. You can now use these
settings, if available, for the remaining value columns.

Text Import Wizard - Step 1 of 3 ? X

The Text Wizard has determined that your data is Fixed Width.

If this is correct, choose Next, or choose the data type that best describes your data.

Original data type

Choose the file type that best describes your data:
1, (® Delimited - Characters such as commas or tabs separate each field,
(_) Fixed width - Fields are aligned in columns with spaces between each field.

Start import at row: | 1 21| File grigind , M5-DOS (PC-8) v

Dideta ha

Preview of file W\auf.uni-rostock.de\homes\profile\vettermann\Desktop\Prospero\QGIS...\data.csv.

oal, Target, Indicator, SeriesCode, SeriesDescription, GeoAreaCode, GeoRreal. ~
7", "7.2", . "7.2_1","EG_FEC RNEW", "Renewable energy share in the total fina|
7", "7.2","7.2_1","EG_FEC_RNEW", "Renewable energy share in the total fina
E S S g -1","EG_FEC_RNEW", "Renewable energy share in the total fina
7T, "7.2","7.2.1", "EG_FEC_RNEW", "Renewable energy share in the total fina|w

< >

Cancel 4' Next = | Finish

(8]

'
-
~J
(O

This screen lets you set the delimiters your data contains. You can see how your text is affected in the
preview below,

Delimiters
[J1ab
|:| Semicalon |:| Treat consecutive delimiters as one
Comm
- i' Text qualifier: |~ v
[ space
|:| Other:
Data preview
zoal [Target [Indicator PeriesCode eriesDescription A
2 2.1 G_FEC_RNEW Renewable energy share in the total £final
2 .2.1 G_FEC_RNEW Renewable energy share in the total £final
2 2.1 G_FEC_RNEW Renewable energy share in the total final
2 -2.1 G_FEC_RNEW Renewable energy share in the total final|w
< >

Cancel < Back 2. Next > | Finish
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This screen lets you select each column and set the Data Format.
Column data format

@ General
®) ‘General’ converts numeric values to numbers, date values to dates, and
Text all remaining values to text,

(O Date: | DMY ~ 2 Advanced... I

O Do not import column (skip)

Advanced Text Import Settings T X

Settings used to recognize numeric data

Decimal separaton: 1 v

o

Thousands separator: |, v
Data preview 1 .
Note: Numbers will be displayed using the numeric

settings specified in the Regional Settings control panel.

Reset Trailing minus for negative numbers

4. 0K | Cancel

Cancel < Back 5. Finish

3 steps to convert csv to Excel
like this:

§

FRERERERRERE ¢

Table view in Excel

Tip: For further processing, it is advisable to create copies of the data for each important step, give them
meaningful names and organize them sensibly on the computer.

So at this point we create a copy of the previously created Excel dataset, once as csv- and once as xIs-file, and
name it UNSDG7210riginal.

Data viewing and revision

Now we look at the table in more detail and prepare it further. The columns have headings whose meaning and
formatting are described in the metadata. A total of 249 lines are occupied (including one heading line). Many of
the attributes (columns) listed in the table are not relevant for the actual calculation and can therefore be deleted.

So we first reduce the table to the necessary columns (goal, target, indicator, geoArea-Code, geoAreaName,
value_2000 .. value_2016) and have a much better overview. After deleting superfluous columns, the revised
CSV file should now look like this:

A B C D E F G H |
1 |Goal Target Indicator SeriesCode SeriesDescription GeoAreaC GeoAreah TimePeric Value
2 7 7.27.21 EG_FEC_RNEW Renewable energy share in the 4 Afghanist: 2000 54.24
3 7 7.27.21 EG_FEC_RNEW Renewable energy share in the 4 Afghanisti 2001 54.06
4 7 7.27.21 EG_FEC_RNEW Renewable energy share in the 4 Afghanist; 2002 43.77
5 7 7.27.21 EG_FEC_RNEW Renewable energy share in the 4 Afghanist; 2003 42.28
6 7 7.27.21 EG_FEC_RNEW Renewable energy share in the 4 Afghanist; 2004 49.84
7 7 7.27.21 EG_FEC_RNEW Renewable energy share in the 4 Afghanisti 2005 40.86
8 7 72721 EG_FEC_RNEW Renewable energy share in the 4 Afghanisti 2006 37.14

Desired appearance of the Excel table
If the column values in your table are below each other (as it is shown here), it is now necessary to transpose the

values per year so that one column is assigned to each value from 2000 - 2016. However, this is only necessary
with the data as CSV, the Excel data are already correctly formatted. A pivot table is used for this purpose. Via

Agrar- und Umweltwissenschaftliche Fakultat e Justus-von-Liebig-Weg 6 ® 18059 Rostock




Professorship for Geodesy
and Geoinformatics

Universitat
Rostock

Traditio et Innovatio

Insert (1.) => Pivot table (2) a new window opens in which the data area (all data cells) is selected (3). With the\
click on 4. a new table sheet with the pivot table is created.

HOME q , NSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
PivotChart
L Mustrations Apps Create PivotChart ? ¥ E
Al N 2 SeriesDescription Choose the data that you want to analyze
O
P B c D (®) Select a table or range 3 |
1 |Goal Target Indicator SeriesCode |SeriesDe5crip Toble/ange: | RERIASKSINAGG . -
2 7 72721 EG_FEC_RNEW Renewable eff O Use an external data source
3 7 7.27.21 EG_FEC_RNEW Renewable er
4 7 7.27.21 EG_FEC_RNEW Renewable er Connecticn name
5 7 7.27.21 EG_FEC_RNEW Renewable erj Choose where you want the PivotChart to be placed
6 | 7 7.27.2.1 EG_FEC_RNEW Renewable el (@ New Worksheet
7 7 7.27.21 EG_FEC_RNEW Renewable erf (O Existing Worksheet
8 | 7 7.27.21 EG_FEC_RNEW Renewable en Location: T
el 7 72721 EG_FEC_RNEW Renewable er Choose whether you want to analyze multiple tables
10 7 7.27.21 EG_FEC_RNEW Renewable er Add this data to the Data Mode!
1 7 7.27.21 EG_FEC_RNEW Renewable er r
—— — 4, E Cancel
12 | 7 7.27.21 EG_FEC_RNEW Renewable en *l
P | = as gy —

Insert the Pivot table
To convert the individual years into columns for each country, it is necessary to select the GeoAreaName, Time-
Period and Value fields in the pivot table settings. These are then assigned to the column (TimePeriod), the rows
(GeoAreaName) and the values.

Drag fields between areas below:

-

; i - -
PivotTable Fields R i
Choose fields to add to report: 4 - TimePeriod -

Goal

Target

Indicator

SeriesCode
SeriesDescription

GeoAreaCode = ROWS 3 VALUES
|+ GeoAreaName

) . GeolreaName * Sum of Value +
v| TimePeriod
v| Value

MORE TABLES...

Defer Layout Update

Formatting the Pivot table
The table should now be displayed as shown here.

A B < +) E F G H ] a1 K L M N ] P [+] R
Sumof Value Oolume sl L b e e S e e e T e
2 [RowLabets z 00 A1 202 203 004 200 2006 2007 008 208 010 2ol 2012 2013 0i4  2ois 2ol
3 lafghanistan 5424 5406 4377 4X2E 4984 4086 3714 3386 2134 17E1 1484 1148 1397 1633 19.31 1836  20.75(
4 lafrica 6084 6042 6001 3938 5939 5828 5815 5749 872 $1.3 573 573 %634 5547 54 557 H
5 (Albania 4144 1913 359 75 3591 3687 NTi 21 B9 w2 i 359 4005 412 69 3861 19,
& lAlgenia 043 043 051 047 044 058 041 0.41 03 031 0.26 018 0.18 013 007 0.05 dq
7 lamerican Samoa ] L] (] a o o 0 o [ ] ] o a or 0.7 ar 0.8 1
& lAmericas 1174 1116 1151 1LE7 1203 1247 1302 1332 1363 1432 141 15.07 15,34 1553 15.53 15.55
§ |Andorma 1451 1539 1583 1852 16.57 1661 1757 1856 1703 1713 1867 1858 1877 1904 1945 1932 l!.!!:
10 jangols 62 TATE 7213 67.31 6448 097 6502 6159 581 579 5646 5504 5463 5311 5384 5345 S4.65)

Ready to use pivot table
Now, each column of the pivot chart can be copied to a new worksheet. To make the country codes also availa-
ble, the pivot table has to be edited. Therefore, only the fields GeoAreaCode (as average value) and GeoAr-
eaName (as row) should be selected.

Agrar- und Umweltwissenschaftliche Fakultat e Justus-von-Liebig-Weg 6 ® 18059 Rostock




Professorship for Geodesy
and Geoinformatics

Universitat
Rostock

Traditio et Innovatio

Drag fields between areas below:

PivotTable Fields

Y FILTERS

COLUMNS

Choose fields to add to report:

Goal

Target

Indicator
SeriesCode
SeriesDescription
GeoAreaCode
GeoAreaName

<

= ROWS Z VALUES

<

TimePeriod GeoAreaName ¥ Average of Ge... ¥

Value

MORE TABLES..

Defer Layout Update

Adding the area codes

The GeoAreaCode column can then also be copied to the new spreadsheet. Now only the columns Goal, Target,
Indicator, SeriesCode and SeriesDescription have to be added. Since these are identical for each row, you can
simply copy them for aII rows and paste them into the new worksheet. The finished data table is shown below.

Ivaiue 2000 value 2001 value 2002 value_2003 Value 2004 Value 2005 Value_2006 Value 2007 Value 2008 Value 2009 Value 2010 Value 2011 Value 2012 Value 2013 Value 2014 Value 2015 Value 2016

\w Indicator seriescod seriesbes
72721 EG_FEC_RRenewabl & Afghanistan 477 a2.28 .86 3718 33.86 2130 178 1148 1.97 1633 1931 18.36 2075
72721 EG_FEC_RRenewabl 2 Africa 60.84 60.42 .01 593 5938 s8.28 58.15 57.49 572 7.3 573 57.25 5634 5547 554 5.7 5563
72721  EG_FEC_RRenewabl 8 albania a1a .13 359 3375 3593 36.87 a7 21 3591 Er2] 72 3596 40,05 am 3869 38.61 39.95
72721 EG_FEC RRenewabl 12 Algeria 0.43 043 051 0.47 o 058 0.41 041 03 031 06 0.8 018 013 0.07 0.06 0.08
72721 EG_FEC_RRenewabl 16 American Samoa a o 0 0 [} ] o 0 0 [ a o 07 07 07 0.89 1
72721 €6 FEC_RRenewabl 19 Americas n7 116 151 1187 1203 1247 13.02 B2 1363 1432 1821 1507 1534 1553 1553 1555 15.99
8 72721 EG_FEC_RRenewabl 20 Andorra 1451 15.39 1583 1652 1657 16.61 1757 1656 17.03 17.13 18.67 1855 .77 1934 1945 19.32 1932
9 72721 EG_FEC_R Renewabl 24 Angola 74.62 B 71 6731 6.8 .97 65.02 6159 581 5796 56.45 55.04 546 5111 5184 53.15 54.65
10 72721  €6_FEC_RRenewabl 660 Anguilla 019 018 o019 017 014 01a 0.12 012 012 012 012 0.13 o1 014 013 o 011
1 72721 EG FEC RRenewabl 25 Antigua and Barbuda 0 o 0 [} [ 0 ) 0 [} [l o 03 ° [} o [ 0

Finished data table

If your selected UN table makes it necessary, assign meaningful names for the headers (it is best not to use only
numbers, otherwise ArcMap will not recognize them as headers). Finally, the data formats of the columns should
be checked or set (select cells => right click => format cells; headers and text as text, numerical values as hum-
ber). For several columns (e.g. all values from 2000 to 2016) hold down the Shift key when selecting headings.

[ H I J K L M N 0 [ Q R T U v w X
ie GeoAreaName Value_2000 Value_2001 Value 2002 Value 2003 Value 2004 Value 2005 Value 2006 Value_2007 Value 2008 Value 2009 Value 2010 Value_2011 Value 2012 Value 2013 Value 2014 Value 2015 Value 2016
16 American Samoa o o [ o o 0 o o o 0 [ 0 0.7 0.7 07 085 1}
28 Antigua and Barbuda 0 0 0 o o o 0 o 0 o 0.29 03 0 0 a o 0
44 Bahamas (] 045 042 169 17 1.84 217 37 215 192 1.66 143 118 084 109 142 14
48 Bahrain o 0 0 [ [ ) o 0 0 o [ o o 0 o ) o
60 Bermuda ) 0 o [ [ esprems o 193 199 236 21
35 Bonaire, Sint Eustatius and S o 0 o o 0 ! lon 01 01 01 01
96 Brunei Darussalam o 0 [ o o [T ooy ey g oy | 0.01 001 001 001 001
36 Cayman Islands 0 o 0 o [ il 0.01 001 001 0.01 0.01
84 Cook Islands o 0 [ [ 0 o —— | 07 0.7 125 125 19
92 Gibraltar o 0 o 0 [ Viahst. 2000 o o a 0 of
16 Guam 0 0 o 0 [} Dmengy - 0 0 o 1.26 3.03
T T Axouning Decimal places: |2 + r T
31 Guernsey o 0 [ 0 [} Date | o 0 0 0 o
33 Isle of Man o o 148 112 .81 (1o e [ wse 1000 separator 1) 7.62 a8s 454 483 a3
32 Jersey ) 0 11.5 3144 2042 304 Fraction Negative numbers: 8.22 5.34 8.38 15.93 14.12
14 Kuwait 0 0 o 0 o o 0 0 0 0 o
38 Liechtenstein o 0 o 0 o i:::‘n B59.51. 58.96 62 62.5 62,93
70 Malta 0 0 0.09 01 012 0. | 26 2.58 393 536 2,86}
00 Montserrat ) 0 [ ° [ | o 0 26.49 26 51.24
80 Northern Mariana islands o o 0 [ [ o 0 0 ) o
12 Oman 0 0 (] [ 0 L o [ (] [ [
85 Palau o [ o 0 [} o o 0.02 0.02 0.02
34 Qatar 0 0 o o [ [ 0 (] 0 o
b e o 5 o o A 0| Numbrss e tor genert oy o umbers. Curency and Acounting ot spclies P — — T ]
34 Sint Maarten (Dutch part) o o 0 o o 0.05 0.05 0.05 0.05 0.05
26 Timor-Leste 0 0 2825 4785 404 2 25.51 2154 18.42 1822 192
38 Tuvalu o o [ o o | o 0 0 816 11.76}
50 United States Virgin Islands 0 0 0 0 ] concel | [0.97 165 276 3.88 3.81

Formatting of all value columns as numbers

Sort by size in ascending order
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1 |GeocAreaCode GeoAreaMame Value 2005 Value 2015
2 1 World 16.50 17.46

3 4 Afghanistan 40.86 18.42

4 8 Albania 36.87 38.62

o 9 Oceania 11.78 13.51

6 12 Algeria 0.58 0.06

7 15 Northern Africa 13.78 9.71

a 16 American Samoa 0.00 0.89

g 20 Andorra 16.90 19.75

21 Northern America 7.64 10.18
24 Angola 70.95 49.57

— | —
E =]

12 28 Antigua and Barbuda  0.00 0.00
13 30 Eastern Asia 14.05 r11.13
14 31 Azerbaijan 3.37 F2.31
15 32 Argentina 8.96 10.04
16 34 Southern Asia 39.29 31.09
17 35 South-Eastern Asia 33.62 30.26
18 36 Australia 6.71 .18
19 40 Austria 24.17 34.39
20 44 Bahamas 1.84 .21

Formatted temporal table
If you look at the data, you can see that some rows (Antarctica) has no values. For the visualization later on it is
necessary to insert therefor no data value. In our case we insert -99. Therefore, the column Value_2000 should
be sorted ascending and the empty fields should be filled with our no data value.

Furthermore, there are some young countries like Montenegro or South Sudan, so there are no values before
their founding year. In this case, we fill the empty fields with the value 0,0. The final table should look like this:

287 72 121 231 Ethiopia 95,95 95,08 95,02 94,75 94,66 95,13 94,94 94,57 94,51 94,61 94,52 24,01 93,75 9 92,07 9217 91,86
267 72 121 180 Democratic Republic of the Cor 87,84 93,34 98,27 97,87 97,88 9742 97,33 97,17 96,97 97,02 96,83 96,15 95,51 93,99 92,87 95,82 97,08
2717 72 121 10 Antarctica 59 59 99 99 59 99 99 99 99 ) 99 5 99 99 99 o9 99
287 72 122 74 Bouvet sland %9 ) £ 99 % 99 £ 99 49 ) 59 9 99 £ 99 e 99
297 72 122 86 British Indian Ocean Territory 99 99 99 29 99 99 99 99 99 ) %9 E:) 99 99 99 o9 99
2307 72 721 162 Christmas sland 99 9 %) 9 9 99 ) 99 99 ES) % £ 99 99 99 e 99
;7 72 721 166 Cocos (Keeling) Islands 5 ) 99 £ 53 £) £ 59 99 ) 59 £ 9 L) 59 %9 £
M7 72 121 239 South Georgia and the South Sz %9 =) 99 99 % £ £ e e £ %9 95 Y £ ) e £
237 72 121 248 Paland islands £ £ ) £ 55 £ ) 55 58 ) 55 55 55 £ 59 e £
2347 72 121 260 French southern Territories 99 £ £ 59 59 e 59 ES 59 £ 59 e e 99 99 ) 99
237 72 721 334 Heard island and McDonald sk -39 ) 59 99 99 59 99 99 59 ) 99 £ 59 99 99 =9 99
267 72 121 336 Holy See &5 -59 93 9% 99 -9 59 99 -99 99 %9 99 -39 e 99 59 L]
2377 72 721 492 Manaco 29 99 99 99 99 99 £ 99 -99 ) 99 -9 -99 99 99 99 99
27 72 721 499 Montenegro 0 0 (] o [ 47,61 44,83 42,27 3876 49,16 49,09 a7 45,86 49,34 45,95 42,96 43,9
297 72 122 530 Netherlands Antilies 99 59 99 £ 99 99 e 99 99 99 99 99 99 99 99 99 99
07 72 121 574 Norfolk island % %9 £ 9 % 99 £ E 49 £ 99 9 99 9 99 £ 99
7 72 12 581 United States Minor Outlying Is %9 53 99 ] a9 99 £ 99 99 £ 99 o 59 £ 99 99 99
w27 72 721 612 preeaim 29 99 £ 99 99 -9 99 99 99 -9 -99 £ -9 99 -99 e -39
M7 72 121 652 Saint Barth |“lemy 99 59 99 99 99 £ £ kL) 99 ES) 99 £ 99 o9 99 ) 59
w7 72 721 663 saint Martin (French Part) 99 59 99 99 99 ) 99 99 -99 99 99 9 99 99 99 99 99
257 72 724 674 $an Marino 99 9 99 99 % 99 £ 99 49 99 % % 9 99 99 % 99
67 72 121 728 South Sudan [ o 0 o 0 [ [ 0 0 [ 0 0 20, 2071 30,4 26,22 285
alr 72 12 732 Western Sahara e 49 a9 99 99 59 9 e a9 59 £ ) ) ) 59 ) )
gl 72 12 744 Svalbard and Jan Mayen Island k] £ 59 e £ e 3 55 55 £ -5 25 £ 99 9 59 £
a7 72 72 772 Tokelau 99 o) 59 99 ) 5 99 9 99 99 55 ) 9 99 99 95 2|

Final data table
The data preparation is now complete, save the table as CSV.
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1 « homes > profile » vettermann > Desktop » Prospero !

Organise » New folder

SDG_Pics o~ Name Dater
Microsoft Excel ne_50m_admin_0_countries

) B:) 721AufbereitetCSV
@& OneDrive 6] 721cleanedCSV
[ This PC g:) data
B:] Indicator_7.2.1_Renewable_energy_share...

= USB Drive (D:)

¥ Network
B8 AGR250
[ ALTLAST
3 ARISTOTELES
3 auf.uni-rostock. ,

File name: | AR (S]

Save as type:  CSV (Comma delimited)

Authors: Ferdinand Vettermann Tags: Add atag

Store as csv
UN Data with LibreOffice Calc
In this section the data are prepared with LibreOffice Calc, this is intended as an alternative to the section Data
preparation with Excel. Before the UN dataset can be evaluated with a GIS, it must be converted into a form that

can be read and processed by a GIS. Open the CSV file of the UN dataset with LibreOffice Calc (Start LibreOffice
=> Open button => Select file) and make the following settings for the import:

Text Import - [data.csv] X
Imiort
oracterset:  |Unicode (UTF-8) v ‘
Zanguage:
From row: 1 =
Separator Options
O Eixed width (@ Separated b
P Y
.
[J1ab [ Comma [] semicolon [ space [ Other
P
[ Mer, e delimiters DTrims aces String delimiter: " |V
] P a
Other Options
[] Format quoted field as text Detect special numbers
q
Fields
Column type: I:|
!Standard ‘Standald |Standard ‘Standald |Standard ~
1 Goal Target 1Indicator SeriesCcode SeriesDescription
7 7.2 7.2.1 EG_FEC_RNEW Renewable energy share in
3 7.2 7.2.1 EG_FEC_RNEW Renewable energy share in
4 7.2 7.2.1 EG_FEC_RMNEW Renewable energy share in
5 7.2 7.2.1 EG_FEC_RNEW Renewable energy share in
6 7.2 7.2.1 EG_FEC_RNEW Renewable energy share in
7 7.2 7.2.1 EG_FEC_RNEW Renewable energy share in
38 7.2 7.2.1 EG_FEC_RNEW Renewable energy share in
n 72 721 F FFC RNFW Ranswahla anarnv chara in ¥
< >

Help 5. ‘ OK | Cancel

Import in LibreCalc
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After importing, all superfluous columns can be deleted. Every column except goal, target, indicator, geoArea—\
Code, geoAreaName, TimePeriod, Value can be deleted.

A | B | c | b | E
1 |GeoAreaCode GeoAreaName TimePeriod Value
_2 | 1 World 2005 16,5
3 | 1 World 2006 16,54
4 1 World 2007 16,35
5 | 1 World 2008 16,46
_6 | 1 World 2009 16,94
N 1 World 2010 16,67
8 | 1 World 2011 16,62
9 | 1 World 2012 16,94
10 | 1 World 2013 17,15
11 1 World 2014 17,3
12 1 World 2015 17,46
13 4 Afghanistan 2005 40,86
14 | 4 Afghanistan 2006 37,14
15 | 4 Afghanistan 2007 33,86
_16 | 4 Afghanistan 2008 21,34
A7 4 Afghanistan 2009 17,81
_18 | 4 Afghanistan 2010 14,84

Desired appearance of the table

In addition to the countries, the UN table also contains aggregated regions. Although these are not relevant for
this evaluation, they do not interfere any further, since they disappear automatically during the later join. One
problem, however, is that the values for the respective years are given in a single column and therefore the coun-
try names occur several times. For this reason, the year numbers (TimePeriod) and their values (Value) must be
broken down into separate columns. This can be done with a pivot chart. Create a new pivot chart and set the
time periods as columns, GeoAreaName and GeoAreaCode as row and values as the column value.

Page Fields: Available Fields:

GeoArealCode
GeoAreaMame
TimePeriod
Value

Column Fields:

TimePeriod

Row Fields: Data Fields:

Sum - Value

GeoAreaCode

Drag the Items into the Desired Position
Options

Source and Destination

Help oK Cancel

Create a pivot chart
The resulting pivot chart is shown below.
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B c | D | E F | [ | H I | J | K | L M| N | o P a |
Sum - Valua Data
2 | GeoAreaN ™4 GeoAreac| 42000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015
3 [Mghanistan |4 54,24 54,06, 43,77 42,28 2084 4085 37,14 33,86 2L 1781 14,84 1148 1307 16,33 1931 18,36,

4_|Aica B 60,84 60.4: 60,0 59,38 59,39 56,28 58,1 57,4 57, 57,2 57 57,2 56,34 55,4 554,
B Ebaﬂm B 21,22 301 35, 3375 3593 3687 3L7 32 359 372 371 35 40,05 412 38,60
5 [Aigeria 12 0.4 0,43 05 047 0,44 0,58 04 0.4 0 03 0,2 0,1 0,15 0,1 0,07
7_[American Sa16 0 0 0 07 ; 07
8 |Amencas |19 1LT. 1L 115 1187 12.03 1247 130 1.1 136 143 142 150 15,34 1553 15,53

Final pivot chart

Don't forget to delete unnecessary rows and columns. Assign meaningful names to the headers. Finally, the data
formats of the columns should be checked or set (select cells => right click => format cells; headers and text as
text, numerical values as number).

E 15
Value 2002 Value 2003 Value 2004 Value 2005 Value 2006 Value 2007 Value 2008 Value 2009 Value 2010 Value 2011 Value 2012 \
43,7 42,28 49,84 40,86 37,14 33,86 21,34 7.81 14,84 11,48 13,97
60,0 59,38 59,39 58,28 58,1! 57,49 7, 7,23 7, 57,2 56,34
35, 33,75 35,93 36,87 317 32,1 359 37,22 37,11 35,9¢ 40,05
0,5 0,47 0,44 058 04 041 0 031 26 0.1 018
0 Format Cells X
1151 1,67 1203
15,83 6,52 16,57 Numbers Font Font Effects Alignment Borders Background Cell Protection
72,13 7,31 64,48
0.1 0,17 0.14 Category Format Language
(] O | [ [Defaut - German (Germany) [~
13.29 12,52 83 User-defined -1235
8.9 9,81 871 123457
18 1] 19 Percent -1.235
24.18 23, 2147 Currency -1.234,57
8,74 7§ 68 Date -1.234,57
11,73 10, 10,22 Time
24,47 224 22,97 Scientific
2.35 2.04 3.07 Fraction
0.4 1 69 17l Boolean Value
0 0 Text
54,34 52,66 52,15 t
13 95 93
52 25 27 Options
69 89 02 . ) = )
310 EiNE] E Decimal places: 31 [0 Negative numbers red
64,04 61T 60,69 Leading zeros: 1 = [ Inousands separator
0
Format code
912 01,0 03,46 L ——
28 zg 265 25,04 Standard
2121 20,14 20,1 User-defined
34,25 34,2 3213
43,02 4531 4539
o om B o
n n n
Formattings

Finally, missing values have to be filled. This is important for Montenegro and South Sudan. The empty fields are
filled with 0,0.

The data preparation is now complete, save the table as CSV.

[E Saveas X
4 [ » ThisPC » Deskiop + Prospero » QGIS » SDG » ~ B | SearchSD »
Organise ~  Newfolder . @
X Name
# Qui

D ne_S0m_sdmin_0_countries

2 Do

4 da

& pictures

B Desktop
FNPS_georel
DG
SDG_Pics

T21AuibereitetCSV
T21cleanedCSV
data

Indicator_7.2.1_Renewable_energy_s

@ OneDrive
[0 This PC

= USB Drive (D)
v

File name: [ 721cleancdCSV_libre -]

Save as type: | Text CSV. -]

~ Hide Foldes Ganca
Store

Country data with ArcMap

General Settings

We also take a look at the data of the country borders and prepare them for a later evaluation and visualization.
To do this, open ArcMap and first set two general properties of the layer: map units in meters, display units in kilo-
meters.
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ODgds B x & - HEEre0 3,
® Q[ Q@ 2x 53 L] B R T  Editore
Table Of Contents x|
- :@\_) 8 4 Data Frame Properties %
0
= i Featwre Cache  AnnolationGroups ~ Eent Indcators  Frame  Size and Postion
General Data Frame Coordinate System Bumination Grids
Name: [Layers
Descrption:
!:rednts:
“inits
Map: Meters. ~
Display: |Kiometers ~

Tip: See Customize > ArcMap Options > Data View tab for
additional options for displaying coordinates in the status bar
Reference Scale: | <None>
Rotation: L
Label Engne: Standard Label Engine v

[A Simulate layer transparency in legends
(] Alow assignment of unique numeric IDs for map service publishing

[0k ] | Abbrechen | | Gbemetmen

General settings for layers
Now add the shapefile with the country boundaries World_Countries_Generalized.shp via Add Data.

G Urtmes - arcitap

- o ES
Tie GOt Vaw Bookmabs e ebcion Geopieceiing  Codomon Wesdows by
ada Bx 0o b lmmm - EEED-
G IR B CR@ B S RES T e o ey
Tabta 04 Cantaras ax

[d]c B
O Layen
L M Daten_Lis Salt Propibte 502 Deelrcp
L

3 i Dmen 5508 Prepin: 200 Doy
[

»
1S T0N BHULEN Chomeem

Shape file of country borders

A look into the table of country borders (right click on the layer in the layer window => open attribute table) shows
that there are 239 entries. Some countries (TYPE) are also assigned to another country (Sovereign country or
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Dependency), for example in the case of the British (e.g. the Cayman Islands namely United Kingdom) and
French Overseas Territories (e.g. French Guiana). Since these territories are also listed separately in the SDG
table, this is not an obstacle.

Tip: Many columns can be hidden, because they are not needed for further processing, e.g. the names in dif-
ferent languages. You can do this by right-clicking on column header => Turn Field Off. Or - better for many
changes - right-click on the layer => Properties => Fields. The following columns should be retained (FID,
shape, featurecla, name, POP_EST ...) INCOME_GRP and ISO_N3.
The clearly arranged table will look like this:
FID | Shape* | NAME POP EST P_RANK MD EST P_YEAR N | GDP YEAR ECONOMY INCOME_GRP Tisons| a
L3 Polygon |Admin-0 country Zmbabwe 13805084 14 28330 2017 2002 2016 |S. Emerging region: G20 S. Low income 716
1 |Polygon | Admin-0 country Zambia 15972000 14 65170 2017 2010 2016 |7. Least developed region 4. Lower middle income 294
z|Polygon | Admin-0 country | Yemen 26036829 15 73450| 2017 2004 20167, Least developed region 4. Lower migdle ncome 857
3 |Polygon Admin-0 country Vietnam 96160163 18 594900 2017 2008 2016 |S. Emerging region: G20 4. Lower middle income 704
4 |Polygon Admin-0 country Venezuela 31304016 15 468600 2017 2001 2016 |S. Emerging region: G20 3. Upper middle income 862
5 |Polygon | Admin-0 couniry | Vatican 1000 3 0 2015 99 olz region: nonG7 2_High income: nonOECD 335
8 |Polygon | Admin-0 country Vanuatu 282814 10 723 2017 2008 2016 |7. Least developed region 4. Lower middle income S48
7 |Polygon Admin-0 country i 29746859 15 202200 2017 1989 20166, ing region 4. Lower middle income 860
% Polygon | Admin-0 country | Uruguay 3360145 12 73250 2017 2004 2016 |5. Emerging region: G20 3. Upper middie income 358
9 |Polygon | Admin-0 country Micronesia 104196 9 314 2017 2000 2016 |6. Developing region 4. Lower middle income 583
10 Polygon | Admin-0 country | Marshal s 74539 8 180 2017 2011 2016 |6, Developing region 4. Lower middle income £
| 11]Polygon | Admin-0 country _|N. Mariana ls 52263 B 882 2017 2010 2013 6. Developing region 2. High income: nonQECD B
12|Polygon __|Admin-0 country _ |US. VirginIs_ 107268 ) 3792 2017 2010 20136 region 2 High income: nonDECD 850
13 | Polygon | Admin-0 country Guam 167358 9 4882 2017 2010 2013 |6. Developing region 2. High income: nonQECD 316
14 |Polygon Admin-0 country American Samoa 51504 8 m 2017 2010 20136, ing region 3. Upper middle income 18
15 | Polygon  Admin-0 country Puerto Rico 3351827 12 131000 2017 2010 2016 |6. g region 2. High income: nonOECD 630
16 | Polygon Admin-0 country United States of America 3268625791 17 18560000 2017 2010 2016 1. Developed region: GT 1. High income: OECD 840
17 |Polygon | Admin-0 country | S. Geo. and the is 30 1 03 2017 99 2016 7. Least developed region £ Low income 239
18 | Polygon Admin-0 country Br. Indian Ocean Ter. 4000 4 160 2013 -98 2013 2. region: nonG7 2. High income: nonQOECD 86
19 |Polygon Admin-0 country Saint Helena 7828 5 Kik] 2017 -99 2010 |6. Developing region 4. Lower middle income 654
20 Polygon __|Admin0 country | Ptcain s 54 1 0 2016 ) 2016 |7. Least developed region 5_Low income 512
21 |Polygon Admin-0 country Anguilla 17087 8 1754 2017 -88 2008 |6. Developing region 3. Upper middle income 660
| | 22 |Polygon |Admin-0 country Falkand Is. 2531 4 2818 2014 -89 2012 |2, Developed region: nonG7 1. High income: OECD 238
23 Polygon | Admin_0 couniry | Cayman Is. 58441 8 2507 2017 2010 2014 |5_Emerging region: G20 2_High income: nonOECD 135
24 |Polygon | Admin-0 country Bermuda 70864 8 5198 2017 2010 2013 |2. Developed region: nonG7 2. High income: nonQECD 60
25|Polygon | Admin-0 country | British Virgin s. 35015 7 500 2017 KT 2010[2. region: nonG7 1. High income: OECD 92
26 | Polygon Admin-0 country Turks and Caicos Is. 52570 8 632 2017 2001 2007 |6 Developing region 2. High income: nonOECD 796
27 |Polygon | Admin-0 country 5292 5 438 2017 -99 2006 |6. region 4. Lower middle income 500
28 |Polygon __|Admin-0 country | Jersey 98840 8 5080 2017 2001 2015 |2, Developed region: nonG7 2. High income: nonOECD 832
| | 2s(Polygon | Admin-0 country | Guernsey 65502 8 3465 2017 2001 20152, Developed region: nonG7 2. High income: nenGECD 831
30 |Polygon | Admin-0 country Isle of Man 88815 8 7428 2017 2006 20142, region: nonG7 2. High income: nonQECD 833
31 |Polygon | Admin-0 country | United Kingdom 64765452 16 2785000 2017 2011 2016 1. Developed region: GT 1. High income: OECD 826
32 |Polygon Admin-0 country United b Emirates 6072475 13 867200 2017 2010 2016 |6, region 2. High income: nonQECD 784
| | 23Polygon | Admin-0 country | Ukraine 44033874 15 352600 2017 2001 2016]6. Developing region 4. Lower middle income 304
34 |Polygon Admin-0 country Uganda 39570125 15 84930 2017 2002 2018 7. Least developed region 5. Low income 200
35 |Polygon | Admin-0 country | Turkmenistan 5351277 13 54720 2017 1995 2016 |6, Developing region 3. Upper middie income 795
36 |Polygon Admin-0 country Turkey 80845215 16 1670000 2017 2000 2016 |4, Emerging region: MIKT 3. Upper middie income: 792
37 |Polygon Admin-0 country Tunisia 11403800 14 130800 2017 2004 2016 6. Developing region 3. Upper middle income: 788
33 |Polygon | Admin-0 country | Trinidad and Tobago 1218208 12 43570 2017 2011 20166 region 2 High income: nonDECD 780
39 | Polygon Admin-0 country Tonga 108479 9 S57 2017 2008 2018 |&. Developing region 4. Lower middle income 776
|40 Polygon | Admin-0 country | Toge 7965055 13 11610 2017, 2010 20167 Least developed region £_Low income 768
41 |Polygon  Admin-0 country Timor-Leste 1291358 12 4975 2017 2010 2016 |7 Least developed region 4. Lower middle income 626
42 | Polygon | Admin-0 country Thailand 68414135 16 1161000 2017 2010 2016 |5. Emerging region: G20 3. Upper middie income 764
43 |Polygon Admin-0 country Tanzania §3950935 18 150800 2017 2002 2018 7. Least developed region S. Low income 234
44 |Polygon Admin-0 country | Tajiistan 8468555 13 25810 2017 2010 2016 |6. ) region 5. Low income 762
45 |Polygon Admin-0 country Taiwan 23508428 15 1127000 2017 -39 2016 2. Developed region: nonGT 2. High income: nonOECD 158
46 Polygon __|Admin-0 country | Syria 18028549 14 50280 2017 2004 2015 |6. Developing region 4_Lower migdle ncome 760
47 |Polygon Admin-0 country Switzerland 8236303 13 496300 2017 2010 20162, region: nonG7 1. High income: OECD 756
48 |Polygon | Admin-0 country Sweden 8960487 13 498100[ 2017 -89 2016 |2. region: nonG7 1. High income: OECD 752
45 Polygon | Admin-0 country | eSwatini 1457152 12 1@' 2017 2007 2016]6. region 4_ Lower migdle ncome 748
50 | Polygon Admin-0 country Suriname S91:19 11 8547 2017 2004 2016 |6. Developing region 3. Upper middie income 740
| | 51|Polygon  |Admin-0 country 5. Sudan 13026129 14 20860 2017 2008 2016 |7. Least developed region 5. Low income 728
52 |Polygon Admin-0 country Sudan 37345935 15/ 176300 2017 2008 20166 region 4_Lower middle income 729 v
o4 1T m B | (0 out of 239 Selected)
ne_S50m_admin_0_ccuntries

Attribute data of the countries

Save the status achieved with ArcMap as Map document with File => Save as with the name Country dataPre-
pared.

Country data with QGIS
General settings

We also take a look at the data of the country borders and prepare them for a later evaluation and visualization.
Open QGIS and adjust the projection of the map window first. Search for the EPSG code 4326, which allows a
global representation.
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[l * @ Layertools
» @ Network analysis
& (Coordinate reference systems of the world Hide deprecated CRSs b G Raster anabynis
®} Macros
il [Coordinate Reference System Authority ID * @ Raster terrain snalysis
5 ~ @ Geographic Coordinate Systems * @ Rastertools
WGS 84 EPSGA326 * Q Vector snalysis
* @ Vector creation
» @ Vector general
» @ Vector geometry
» Q Vector overlay
. 0 Layer Sty Processing Toobox
Wer e ] Search QMS ax
Extent Search siring., |
~180.00, -50.00, 180.00, 90.00 =
Fiter by extent| | a1 -
4proj=longlat +datum =\WGEB4 +no_defs
Last used:
4 ESRI Satellite (ArcGIS/World_Tmagery) @ s
B 1 i, et a i
v Datum Transformations.
datum transformation If several are avalable (defined in global setting]
&
Source CRS Source datum transfom _ Destination CRS _ Destination datum transform
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o Cancel nogly Heb
FEresh aeodata for your project
Coordnate| 186.5,90.1 |95 Sclle 195003641 ~ @ Magnifier | 100% 2| Rotaton [0,0° [2] ¥ Render priane @

Set projection in QGIS
Then add the countries as a new vector layer to visualize them in QGIS. This can be done via Layer => Add Layer
=> Add Vector Layer.

(Q Data Source Manager | Vector X
9!

a
Souece Type

v(; Vector

Raster

® Fie () Directory () Database () Protocol: HTTP(S), doud, etc.

Encoding UTF-8 b
1/

:‘!’ Mesh

Source

Delimited Text
. Vector Dataset(s) ofile\vettermann\Desktop\Prospero\QGIS\SDGYne_50m_admin_0_countries\ne_S0m_admin_0_countries.shp &

‘.1.4 GeoPackage

l‘i SpatiaLite

PostgreSQOL
Add a vector layer
The result should look like the following figure:
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Shape file with the boundaries

A look into the table of country boundaries (right click on the layer in the layer window => open attribute table)
shows that here some countries (ADMIN) are assigned to another country (SOVEREIGNT), for example in the
case of the British (e.g. the Cayman Islands namely United Kingdom) and French overseas territories (e.g.
French Guiana). Since these territories are also listed separately in the SDG table, this is not an obstacle.

Tip: Columns can be hidden by right-clicking on Column header => Hide Column. Another way is to hide multi-
ple columns with a click on organize columns. The following columns should be still visible: featurecla, Name,
POP_EST .. INCOME_GRP und ISO_N3.

The table should look like the following:

() ne_50m_admin_0_countries :: Features Total: 241, Filtered: 241, Selected: 0

J o S L v ES P B & &
featurecla NAME | POP_EST | POP_RANK GDP_MD_EST POP_YEAR INCOME_GRP ISO_N3
1 | Admin-0 country S.Sudan 13026129 14 20880,00 2017 5.Low income | 728
.2 .Admin-O country Somaliland 3500000 12 12250,00 2013 4. Lower middl... 706
3 .Admin-o country Serbia 7111024 B 101800,00 2017 3. Upper middl... 688
4 lAdmin-O country Sudan 37345935 15 176300,00 2017 4. Lower middl... 729

Attribute table of the countries

Modeling

Problem Data Data pre- Evalua- Visualisa- Interpreta-
statement search paration tion tion tion

In the next step, the data is modeled using a flowchart to indicate which data is linked and how. Detailed instruc-
tions can be found in the tutorial Modeling in UML and ER1° as well as in the tutorial UML Class and Activity Dia-

gram?t,

10 https://learn.opengeoedu.de/tutorials/OGE-Tutorial_UML_Vorlesung-en.pdf
1 https://learn.opengeoedu.de/tutorials/OGE-Tutorial_UML_uebung-en.pdf
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The activity diagram models the intended sequence, the class diagram models the data and its link. Open \
draw.io?, a program to produce various chart types, and use the blocks on the left side to draw a corresponding
diagram. You can export the diagram as PNG under File => Export as.

/— SDG Indicator \

Import in ArcMap

Colleet and Scientific elaboration
interprete results document

Read and understand Define your Prepare SDG data,
SDG meta data research question statistical evaluation

Evaluation in
ArcMap

Country borders,

read and understand
meta data

[ Symh[g;ggton and '—’ Map, diagram

Import in Archap

; Country berders /

UML activity diagram

UN SDG Class diagram)

SDG Indicators  shesessrassaesees {>  country borders
+ Goal: Text + Geometry: Polygon
+ Indicator: Text + Sovereignt: Text
+ Description: Text + Pop_Est: Integer
+ GeoAreaCode: Integer ! LH e ISO_N3: Integer
+ GeoAreaName: Text + Pop_Year: Integer
+Year: Integer + GDP_Year: Integer
+ Value: Float + GDP_Est: Integer
+ Source: Text :
+ Units: Text

V4 A4

- define coordinate reference s!,.'stemll
- evaluate data spatially
- visualize in thematic cartographic form

- calculate statistical measures
- create diagrams for visualization

UML class diagram
Evaluation

Problem Data Data pre- . Visualisa- Interpreta-
] Modeling . .
statement search paration tion tion

The evaluation can be done with the commercial desktop GIS ArcMap from ESRI, the open source desktop GIS
QGIS or any other familiar GIS environment. Selected steps are shown here first in ArcGIS, then in QGIS. The

2 https://www.draw.io/
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temporal development is again considered from the point of view of the factual data, for which an evaluation usim
spreadsheet software, i.e. Excel or Libre Calc, is recommended. A spatial reference is established by comparing
selected countries with the worldwide development.

with ArcMap
Import data

Use Add Data to add the formatted UN data record to your open ArcMap. The table appears in the Table of Con-
tents of ArcMap. Right-click on the table and choose Open from the context menu. If the table has a similar shape
to the one in the picture below, the previous work in Excel or LibreCalc was successful.

Ogas B x &~ MES @adE
®RAMQ - HI[x] @ n R ¢, Snapping ~[C
Table Of Contents 3 x 110 |20 |30 |40 |
::Uﬂ &

= = layers

=l £ R\Profile\Personal\UN_SDG_Uebung ﬁ_
(=3
o
o~

UN_SDG_Renewable_Energy.csv

Table 0O x
H- B-ah
UN_SDG_Renewable_Energy.csv x
- GegAreacM GeoAreaName Value 2005 Value 2015 A
1 | World 2005 16,5 17,46
4 | Afghanist: 2005 40,88 18,42
» 8 | Albania 2005 36,87 3862
9 | Oceania 2005 11,78 13,51
12 | Algeria 2005 0,58 0,06
15 | Northern Africa 2005 13,78 9.1
16 | American Samoa 2005 0 0.89 |
20 | Andorra 2005 16,9 19,75
21 | Northern America 2005 764 10,18
24 | Angola 2005 70,95 49,57
28 | Antigua and Barbuda 2005 0 0
30 | Eastern Asia 2005 14,05 11,13
31 | Azerbaian 2005 3,37 2,3
32 | Argentina 2005 8,96 10,04
34 | Southern Asia 2005 39,29 31,09
35 | South-Eastern Asia 2005 3362 30,26
36 | Australia 2005 6,71 9,18
40 | Austria 2005 2417 3439
44 | Bah 2005 1,84 1.21
48 | Bahrain 2005 0 0
50 | Bangladesh 2005 50,78 3475
51 | Armenia 2005 6,49 15,79
52 | Barbados 2005 991 2,79
53 | Australia and New Zealand 2005 10,12 1223
56 | Belgium 2005 2,47 92| w
o4 3 0m E (0 out of 252 Selected)
UN_SDG_Renewable_Energy.csv

UN-SDG-Tabelle

If you have not already done so in the formatting step, now also open the attribute table for the country data
World_Countries_Generalized.shp via Add Data.
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1 1 MPrefie Persnal SO Vebung i
= [ me_50m_adem 0 countries /;7,
= 3 RiPrefi Personal D6 UEbung
B UM 506, Fnevgycss
Data preparation

The two opened tables can be arranged side by side:

Shape files of country borders

with Arrange Table e.g. vertically side by side.

&

gk €

Joins and Relates
Related Tables
Create Graph...

Add Table to Layout
Reload Cache
Print...

Reports

Export...

Appearance...

Eorgia and the land

Move the active table window to a
new vertical tab group.

M Find and Replace...
% Select By Attributes... FORMAL EN POP EST | POP RANK
of Zimbabwe 13805084 14
of Zambia 15972000 14
teh Selecti of Yemen 28035829 15
B3 Switch Selection Republic of Vietnam 96160163 16
[E Selectan In Republic of Venezuela 31304016 15
. the Vatican Ciy 1000 3
Add Field... of Vanuatu 282814 10
- of Uzbekistan 29748859 15
EE  Turn All Fields On 3360148 12
Show Field Aliases 104196 ]
ryr o " 24539 B
| Arrange Tables » | New Horizontal Tab Group 2263 8
Restore Default Column Widths | New Vertical Tab Group 7ﬁ 3
Restore Default Field Order New Vertical Tab Group t

[ 7828
Henderson, Ducie and Oeno Islands] 54 1
L 17087 3
lslands 2931 4
lslands 58441 8
das or Somers sles 70264 8
irgin Islands 35015 7
¥ )d Caicos Islands 52570 8
5292 5
of Jersey 88840 8
i of Guernsey 66502 8
ARA1S a
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2% %H \

UN_SDG_Energy.csv X ne_30m_admin_0_countries X
|| AreaCode GeoAreaame Value 2005 | Value 2015 A SOVEREIGNT TYPE ADMIN ADMO A3 | A
585 |Pakistan 4752 46 48 || Vanuatu Sovereign country Wanuatu VUT
525 |Palau 0 I Uzbekistan Sovergign country UUzbekistan UzB
591 |Panama 27,04 223 Uruguay Sovergign country Uruguay URY
598 |Papua New Guinea 5856 525 Federated States of Micronesia Sovergign country Federated States of Micronesia FSM
600 |Paraguay 68,82 61,68 || Marshal lslands Soversign country WNarshal lslands WHL
604 [Peru 273 255 || United States of America Dependency Northern Mariana lslands NP
608 |Philippines 3,43 2745 |_{United States of America Dependency United States irgin Islands VR
616 | Poland 721 11,91 |_{United States of America Dependency Guam GUN
620 |Portugal 18,07 2116 |_{United States of America Dependency American Samoa ASH
630 | Puerto Rico 055 1,84 |_{United States of America Dependency Fuerto Rico PRI
634 | Qatar 0 0 || United States of America Country United States of America UsA
410 |Republic of Korea 087 2 || United Kingdom Dependency South Georgia and the lslands. 5G5S
488 |Republic of Moldova 431 1427 United Kingdom Dependency British Indian Ccean Territory 0T
£33 |Réunion 857 1749 United Kingdom Dependency Saint Helena SHN
542 [Romania 1851 237 United Kingdom Dependency Pitcairn Islands PCN
B peen etertin B | [ 4 e e
54 |Saint Helena a4 [E R 2
Mo % m E (D out of 252 Selected) Mo Uorom E (0out of 241 Selected)
UN_SDG_Energy.csv ne_30m_admin_0_countries

Left: UN data, Right: Country borders

In the next step, the join of the two tables is prepared. To do this, a column must be found that is identical in both
tables for each country and uniquely assigns a value to each country. The country name is only suitable to a lim-
ited extent, since the spelling for the countries in the data records is not uniform. For example; Viet Nam and Vi-

etnam, Republic of Korea and South Korea etc. More suitable is the country code according to ISO 3166-1 given
in both data sets. The matching column is called geoAreaCode in the UN data set and ISO_N3 in the data set of
the country boundaries.

ERE- L1
UN_SDG_Energy.csv X ne_50m_admin_{_countries X
AreaCode GeoAregName | Value 2005 | Value 2015 A SOVEREIGNT TYPE NAME 150 N3 A
1| World 165 1746 Afghanistan Sovereign country  [Afghanistan 004
4| Afghanistan 40,86 1842 Albania Sovereign country  |Albania 008
§|Albania 36,87 862 Antarctica Indeterminats Antarctica 01
9|Oceania 11,78 13,51 Algeria Sovereign country | Algeria 0z
12| Algeria 0,58 008 United States of America Dependency American Samoa 016
15 [Northern Africa 13,78 am Andorra Sovereign country  |Andorra 020
16| American Samoa 0 029 Angola Sovereign country  |Angola 024
20| Andorra 163 1878 Antigua and Barbuda Sovereign country  [Antigua and Barb. 02
21 [Northern America 754 10,18 Azerbaian Sovereign country  |Azerbaijan 031
24|Angola 7085 85 Argentina Sovereign country  [Argentina 032
28 | Antigua and Barbuda 0 ] Australia Country Australia 038
30 |Eastern Asia 14,05 1113 Australia Dependency Ashmore and Cartier ls.  |036
31| Azerbaian 337 Pl Austria Sovereign country | Austria 040
32 |Argenting 8,96 10,04 The Bahamas Sovereign country  |Bahamas 044
34[Southern Asia 3928 31,08 Bahrain Sovereign country | Bahrain 048
35(South-Eastern Asia 3362 30,26 Bangladesh Sovereign country  |Bangladesh 050
36 |Australia 671 918 Armenia Sovereign country  [Armenia 051
40 |Austria 2417 3439 Barbados Sovereign country | Barbados 052
44|Bahamas 1,84 121 Belgium Sovereign country  [Belgium 0%
43 |Bahrain 0 ] United Kingdom Dependency Bermuda 080 v
50|Bangladesh 50,78 T Bhodon Frumrninn ansindns - [Bhidan ned
<1 armenia £ 49 1579 13 %
Mo 4 v v BB outof 25 Seecte) o4 770 (B3 Ooutof 24 Selected)
UN_SDG_Energy.csv ne_30m_admin_0_countries

Common key: right geoAreaCode, left ISO_N3

But even here there are still small discrepancies, so the codes were entered in the UN data set without and at the
country borders with leading zeros (4 vs. 004). At this point, the two tables still have to be harmonized. The fast-
est way to do this is probably to delete the leading zero of the data set of the country borders (ne_50m_ad-
min_0_countries) (to do this, open the table and click on the Edit Mode button). On this occasion you can also
add the missing ISO codes for some countries (Norway: 578, Kosovo: 412).

The next problem is that the country code column is created as a string for the country borders and as a long for
the UN data, so the join does not yet work. To solve this problem, open the table of country borders and add a

Agrar- und Umweltwissenschaftliche Fakultat e Justus-von-Liebig-Weg 6 ® 18059 Rostock




Universitat

Professorship for Geodesy
Rostock

and Geoinformatics

/" Traditio et Innovatio

column with data type Long. Right click on the new column => Field Calculator and enter "New field" = [ISO_Nm
The join can now be performed via this newly created field.

Joining two tables
The join is finally performed via Right click on Layer of country borders => Joins and Relates => Join with the fol-
lowing settings:

1. Select column with the country name of the country boundary data set.

2. Select the dataset which should be connected to the country boundary dataset.
3. Select column with country name of the UN dataset.

4. Keep all records to keep rows to which no values have been assigned.

Join Data X

Join lets you append additional data to this layer's attribute table so you can,
for example, symbolize the layer's features using this data.

| What do you want to join to this layer?
: Join attributes from a table ~

1. Choose the field in this layer that the join will be based on:

[150_Long ~]

2. Choose the table to join to this layer, or load the table from disk:

&2 Csv_Aufbereitet.cov M=)

Show the attribute tables of layers in this list

3. Choose the field in the table to base the join on:

| geoAreaCode | ~ |

Join Options
(®) Keep all records

All records in the target table are shown in the resulting table.
Unmatched records will contain null values for all fields being
appended into the target table from the join table.

(") Keep only matching records

If a record in the target table doesn't have a match in the join
table, that record is removed from the resulting target table.

Validate Join

| About joining data Cancel

Join process
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ne_30m_zdmin_0_countries X
TYPE ADMIN IS0 K3 | AreaCode GeoArealiame Value 2005 | Value 2015 A

Soverein country | 580 Tomé and Principe 678 678530 Tome and Principe % 4108
Sovereign country | 5an Maring 674 <ull ul Ml <l

Sovereign country | Samoa 882 882 | Samoa &13 un
Sovereign country | Saint Vincent and the Grenadines 670 670 |5aint Vincent and the Grenadines 58 581
Soversign country | 3aint Lucia 662 662 |Sait Lucia 25 213
Sovereign country | Saint Kits and Nevis 659 659 |Saint Kitts and Nevis 2558 164
Sovereign country | Rwanda 645 646 |Rwanda 824 86,66
Sovereign country  |Russia 643 643 |Russian Federation 362 33
Sovereign country | Romania 642 642 |Romania 1851 a7
Sovereign country | Catar 634 634 | Catar 0 0
Sovereign country | Portugal 620 620 |Portugal 1807 2716
Sovereign country | Poland 616 616 |Poland 721 1191
Sovereign country | Philppines 608 608 |Philppines 14 745
Sovereign country | Penu 604 604 Pery 21 285
Sovereign country  |Paraguay 600 800 |Paraquay 6852 6168
Sovereign country | Papua New Guinea 5% 598 |Papua New Guinza %56 525
Sovereign country | Panama kil 581 |Panama 20 A4
Sovereign country | Palau 585 585|Palau 0 0
Sovereign country | Pakistan 36 586 | Pakistan 4152 46 48
Sovereion countrv 10man 912 51210man 1 0

Join result

The next step is to tackle the actual goal of presenting the trend in renewable energies from 2005 to 2015. To do
this, you have to create a new field in the table in which the difference is to be stored. Open the table of the
Shapefile Layer => Table Options => Add Field. Then choose a meaningful and short name for the difference
(e.g. 2000_2016) and set the data type as Double, with precision 8 and scale 2. Right click on the new field =>
Field Calculator. In the Field Calculator, subtract the values for the year 2000 from the values for 2016.

Before we go to the visualization, let's take a closer look at the data. You can see that some countries have a
<NULL> value. In contrast to the number 0, this indicates that no values are available here (in contrast to Palau,
for example, which had a 0% share of renewable energies in 2000 and 0% in 2016 and consequently also had 0
percentage points growth). The <NULL> values were calculated in the Field Calculator as the number 0 and
would therefore also be visualised and thus falsify the information content. Therefore you need to edit the table
again (Editor => Start Editing). Arrange the data according to the 2000_2016 column (double-click on column
header). Change the difference 2000_2016 of all zero-value lines by marking them with the CTRL key pressed
and entering a unique value here via the calculator (Field Calculator), which otherwise does not appear in the
data (e.g. -99). This value can then also be displayed separately in the visualization.
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e
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Table
ERE T L
ne_50m_admin_(_countries
—
SOVEREIGNT ] TYPE ] AD ! ! ! alue 2005 Value 2015 20087015
|_|Vatican Sovereign count Vatican Field Caleulator <Nulk- ]
|_|United Kingdom Dependency South Georgia and the <Null= 0
|_|United Kingdom Dependency Briish Indian Ocean Te  p. oo <Null= 0
United Kingdom Dependen Pitcaim Islands . <l 0
: Untted Kingdom Cn:ntry_cr Jersey @ scipt Opython <Null= 0
United Kingdom Countr Guernsey . <l 0
: United Kingdom Cnuntg lsle of Man LS Tope: PEEE <Null= 0
|_|Taiwan Sovereign count Taivan ne_50m_adin_0_countries. SOVERE A | (® Number Abs () <Nulk- 0
Somaliznd Somaliend ne_50m_adrin_0_ countries. TYPE 22;(( )) <Nul- ]
San Marino Sovereign count San Marino . - <Nulk- 0
Westem Sahara Indterminate Western Sahara nE_EDrn_adm!n_D_ceunh!es‘ADMIN_ Ostrg Bxp() <Null> 0
Soversign count Wonaco ne_50m_adrin_0_counties. 50_N: (C)bate Fix() <Null= 0
Kesovo 12 _50m_din__counties Areaco int() <Nl 0
France Dependency Sait Martin ne_50m_admin_0_countries, 2005_2 Log () <Nul= 0
_30m_admin_0_t X Sin()
France Dependency Saint Bartheler UN_SDG_Energy.csv. AreaCode sqr() <Nulk> ]
= ot S| 0y G ) — 3
Northern Cyprus Sovereign count Northern Cyprus < ¥ <Nulk> 0
Australia Dependency Indian Ocean Territoried <Null= 0
Austraiia Dependency Heard sland and MeDo| L] Show Codeblock =[] [&][<][-1]= <Nul= ]
Australia Dependency Norfolk lsland ne 50m admin 0 countries.2005 2015 = <Null= ]
Kashmir Indeterminate Siachen Glacier — = <Nulk> 0
Antarctica ndetermnate Antarcica £ EITS 0
Netherlands Country Sint Maarten <Nulk> 0
Unted States of America Dependency Northern Hariana islan 0 0 0
United States of America Dependency Guam 0 0 0
United Kingdom Dependency Wontsgrrat 0 0 0
Qatar Sovereign count Qatar 0 0 0
Fael 0 0 [
_ Sovereign count Oman 0 0 0
Kuviat I U [
France Dependency Wallis and Futuna 0 0 0
Bahrain Sovereign count Bahrain 1] 1] 0
ntigua and Barbuca 0 0 0
United Kingdom Dependen Cayman lslands 0 0,01 oM
Saud Arabia 5u3um Sa:di&rab\a Ehout oot el Clear load... | | Save.. 001 001 0
Brunei |Sovereign country [Brunei 0 0,01 0,01
Turkmenistan Turkmenistan 0,07 0,04 0,03
Algeria Sovereign country Algeria Zm 0,58 0,06 -0,52
Mairn Cmrarainn raintne Thanm n nna nng
"o 0 v n ES @ outof 1 electe
ne_30m_admin_{_countries
SOVEREIGNT TYPE ADMIN 150 N3 | AreaCode | AreaCode | GeoAreaName Value 2005 Value 2015 2005 2015
France Dependency French Southern and Antarctic Lands 260 260 | =Null= <Null= <Null= <Hull= -5
_|Finland Country Aland 248 248 | <Null=- <Nulk <Nulk <Hull= -9
Northern Cyprus Soversign country Northern Cyprus 98 -9 [<Nulk= <Null= <Null= <Null -5
|| Australa Dependency Indian Ocean Territories -39 -89 <Null= <Nl <Nulk <Hull= -9
|| Australa Dependency Heard Isiand and lcDonald lslands 3 334 <Null= <Nulk <Nulk <Hull= -9
Australa Dependency Norfolk lsland 574 574 <Null- <Null= <Null= <Null- -5
|| Kashmir Indeterminate Siachen Glacier -3 -89 <Null- <Nulk <Nulk <Hull= -89
Antarctica Indeterminate Antarclica 10 10 |<Null= <Null> <Null> <Nl -9
Netherlands Country Sint Maarten 534 534/ <Null- <Null= <Null= <Null -5
United States of America Dependency Northern Mariana lslands 580 580 580 | Northern Mariana lsland 0 0 0
United States of America Dependency Guam 316 316 316 | Guam 0 0 0
|_|United Kingdom Dependency lontserrat 500 500 500|Montserrat 0 0 0
Qatar Sovereign country Qatar 634 634 634 [Qatar 0 0 0
|_|Palau Sovereign count Palau 585 585 585 | Palau 0 0 0
Oman Sovereign country Oman 5§12 5§12 512|0Oman 0 0 0
|| Kuwait Sovereign country | Kuwatt 414 414 414 |Kuwait 0 0 0
France Dependency Walls and Futuna 876 &76 876 [Wallis and Futuna lslan 0 0 0
|| Bahrain Sovereign country | Bahrain 48 48 48| Banrain 0 0 0
|| Antigua and Barbuda Sovereign count Antigua and Barbuda 28 28 28| Antigua and Barbuda 0 0 0
United Kingdom Dependency Cayman lslands 136 136 136 |Cayman lslands 0 001 om
Saudi Arabia Sovereign count Saudi Arabia 682 682 682 [Saudi Arabia oM 001 ]
Brunei Sovereign country Brunei 9% 9% 95 | Brunei Darussalam 0 001 0m
|_|Turkmenistan Sovereign country Turkmenistan 785 785 795 Turkmenistan 007 0,04 -003
Algeria Sovereign country Algeria 12 12 12 [Algeria 058 0,06 052
Nauru Sovereign country | Nauru 520 520 520 |Nauru 0 0,08 0,08
United Kingdom Dependency Anguila 660 660 660 | Anguila 014 0,11 0,03
United Arab Emirates Sovereign country United Arab Emirates 784 T84 784 |United Arab Emirates 0N 014 003
Trinidad and Tobago Sovereign count Trinidad and Tobago 780 T80 780 |Trinidad and Tobago 053 028 025
Netherland Country Curacao 531 531 531|Curacao 026 035 009
Syria Sovereign country | Syria T80 T80 760 [Syrian Arab Republic 21 052 -159
United Kingdom Dependency Turks and Caicos lslands 796 796 796 |Turks and Caicos kslan 054 057 003
Singapore Sovereign country Singapore 702 702 702|SW_@& 054 07 017
I Sovereign country | Iraq 368 368 @lm 23 08 -5
o BB e o
Replace NULL values with -99
with QGIS
Import data
The next step is to add the UN dataset. You can do this via Layer => Add Layer => Add Delimited Text Layer.
The new table is shown in the QGIS layer manager.
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() Data Source Manager | Delimited Text X
File name | \\auf.uni-rostock.de\r \QGIS\SDG\72 1deanedCSV.csv &«
1 Layer name |7 ¥
w File Format
CSV (comma separated values) Tab Colon Space
Regular expression delimiter Semicolon 3 v | Comma Others
@ Custom delimiters etk Escape
GeoPackage
. P Record and Fields Options
SpatiaLite
w Geometry Definition
- PostgreSQL
Point coordinates
. MSSQL Well known text (WK
®) No geometry (attribute only table)
Oracle
Geometry CRS invalid projection b
DB2
+
‘ P Layer Settings
Virtual Layer
Sample Data
WMS/WMTS . . 8 — -
Goal Target Indicator SeriesCode SeriesDescription GeoA
Wes 1|7 72 (721 EG_FEC_RNEW Renewable energy share in the total final energy consumption (%) 16
2 |7 T2 7.21 EG_FEC_RNEW Renewable enerqy share in the total final energy consumption (%) 28 '~
[ b
WFS
+ -
a ArcGIS Map Server
cose &, add Help
@ T2icleanedCSV = Festures Totak 273, Fiteed: 273, Selected: 0 - 8 %
2 & LYRDL s Fe
Goal Target Indicator SenesCode SenesDescription  GeoAreaCode  GeoAresName Value 2000 Value 2001 Vahoe 2002 Value 2003 Velue 2004 Value 2005 Value 2006 Value 2007 Value 2008 Value 2009 Value 2010 Value 2011 =
1 7| T2 728 EG_FEC RNEW  Renewable ener. 234 Faroe bslands 2 253 wm 3 EAE) 149 Ebc] 395 i 44 w 4
2 7 T2 721 EG_FEC RNEW  Renewable ener.. 62 Saint Lucia 28 3 (b 4 25 25 248 P 2% 226 22 i
s B 72721 EGFECRNEW  Renewsble enes, 398 Kuaakhstan P 24 wn 2 ™ 20 an i s w 13 '
4 7 72121 EGFECRNEW  Renewsble ener. 778 Tangs 218 a7 28 20 21 2 . 27 19 " 101 1
3 7 2121 EG_FEC RNEW  Renewable ener.. 343 Hungary 517 a2 an in 463 .28 786 9 8% 1229 1346 1
6 7 2121 EGFECRNEN  Rencweble encs. 30 s 53 56 624 534 67 s an 08 1254 s 1
7 7 72121 EG_FEC_RNEW  Renewable sner. 135 Caucasus and 502 48 495 506 497 49 an 439 an 46 449
2 7 T2 121 EG_FEC_RNEW  Renawable ener. 422 Labanon a9 s 5T 746 652 652 T3 857 567 a8 52
') EG_FECRNEW  Reneuesble ener. 151 Eastern Europe an 434 an 42 45 4z 478 501 508 564 57
0 7 EGFECRNEW  Renewable ener... 143 Central Asis 38 an 18 ast wm 412 am 3 23 3 14
" 7 T2 120 EG_FECRNEW  Renewable ener.. 392 Japan 385 e Rl 428 43 40 44 45 44 445 4™ £
12 7 T2 721 EG_FEC_RNEW  Renewable ener. TO3 Slovakia 3an L] s 535 625 LEL 57 823 .8 ] o2 ¢
13 7 EG_FEC_RNEW  Renewable ener.. 36 Belgum 143 13 16 149 a0 247 2 2] N 483 EE ) €
14 7 £ EG_FEC RNEW  Renewable ener. B4 Ukrsine 15 123 103 o w 127 175 23 an 2% 28 i
15 7 T2 728 EG_FEC_RNEW  Renewsble ener. 860 Uzbekstan 12 1.2 118 152 185 186 1. 138 pr2) 26 257
1 7 72 721 EGFECRNEW  Renewable ener. 583 Micronesi (Fe. 19 o 1 " e 1 15 125 14 13 1 1
w 72121 EGFECRNEW  Renewsble enes, 238 Faland hkands 119 1 1o a9 0ss a8 on an 7 o ™ ¢
i 7 EG_FECRNEW  Renewable ener.. 887 Yemen 118 107 106 0% 091 089 033 0% (1) 088 09 1
1 7 EGFECRNEN  Rencwable ener.. 92 Brtish Virgin s, 105 106 i o97 0% 0% o an v on on
20 7 EGFEC_RNEW  Reneweble ener. 826 United Kingdo. . 0% 08 o9 0% 14 135 155 184 2. 338 367 “‘
21 7 EG_FEC_RNEW  Renewable ener.. 462 Maldives 2 2% L7 wm 167 195 15 152 153 42 13 1
2 7 EGFECRNEW  Fanewable ener. 20 Jardan 2 1] 28 198 18 1 22 28 2n m 258 :
23 7 21121 EG_FEC RNEW  Renewable ener. 31 Azerbaian 207 178 238 2% am 136 286 im 3. w2 445 1
A 7 72721 EG_FEC RNEW  Renewable ener... 434 Libys 20 e 191 195 187 182 188 2 188 172 157 i
2 7 72721 EGFECRNEW  Renewsble enes, 72 rdland 0 wr 2 wm 23 2 s ™ an n 525 i
% 7 72121 EGFECRNEW  Renewabla ener. 760’ Syrion A Rep.. 2 207 161 1w 28 2 . 157 2 0ss 139 1
& 72/121 £GFECANEW  Renewable ener. 528 Nethedands 175 v 15 192 224 an 35 am 391 4 187
2 7 72 721 EGFECRNEW  Rencorsble ener. 474 Martiague 168 16 165 158 %) 18 "w 2% an 2w 287 :
5 7 72 721 EGFECRNEN  Rencwebic ener.. 12 aigesa s I ost o oa ass o 041 o on 026 ¢
0 7 72 721 EGFECRNEW  Renewable ene, 368 Inq a1 035 o 03 036 23 25 2 s s I 1
3 72721 EG_FEC_RNEW  Renewable ener. 702 Singapare a3 o 038 s 058 054 052 05 043 o8 048 5

UN-SDG table
Data preparation

To view the UN SDG table as well as the attribute table from the countries, you can move them next to each other

with dock attribute table.
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ne_50m_admin_0_countries :: Features Total: 241, Filtered: 241, Selected: 0 @68 721cleanedCSV :: Features Total: 273, Filtered: 273, Selected: 0 @2
/ ~ € LT E S 2 E » e £ L T E % § B2 B Ee

featurecla MNAME POP_EST POP_RANK GDP_MD_EST = Goal Target Indicator SeriesCode SeriesDescription  GeoAreaC ™
1 |Admin-0 country S.Sudan 13026129 14 20880,00 i 7 72721 EG_FEC_RNEW Renewable ener...
2 |Admin-0 country Somaliland 3500000 12 12250,00 2 g 72721 EG_FEC_RNEW Renewable ener...
3 |Admin-0 country Serbia 7111024 13 101800,00 3 7 712|721 EG_FEC_RNEW Renewable ener...
4 | Admin-0 country Sudan 37345935 15 176300,00 4 7 72 721 EG_FEC_RNEW  Renewable ener...
5 |Admin-0 country Somalia 7531386 13 4719,00 5 7 72 721 EG_FEC_RNEW Renewable ener..,
6 | Admin-0 country United Kingdom 64769452 16 2788000,00 6 il 72 721 EG_FEC_RNEW Renewable ener...
7 |Admin-0 country | Sint Maarten 42083 7 365,80 7 7 72721 EG_FEC_RNEW  Renewable ener...
g8 | Admin-0 country Indian Ocean Ter. 2801 4 42,02 8 ) 72 721 EG_FEC_RNEW Renewable ener...
9 |Admin-0 country Australia 23232413 15 1189000,00 9 7 72721 EG_FEC_RNEW  Renewable ener..
10 |Admin-0 country Cyprus 1221549 12 29260,00 10 7 72 721 EG_FEC_RNEW Renewable ener...
11 |Admin-0 country N. Cyprus 265100 10 3600,00 n 7 72721 EG_FEC_RNEW  Renewable ener..,
12 |Admin-0 country France 67106161 16 2699000,00 12 7 72 724 EG_FEC RNEW  Renewable ener...
13 |Admin-0 country Kazakhstan 18556658 14 460700,00 13 7 72721 EG_FEC_RNEW Renewable ener...
14 |Admin-0 country Kosovo 1895250 12 18490,00 14 7 72721 EG_FEC_RNEW Renewable ener...
15 .Adrmn-() country Curagao 149648 9 3128,00 15 7 72721 EG_FEC_RNEW Renewable ener...

= . - - X -

¥ Show All Features _ E T Show All Features _|
Coordinate | 438.1,-21.3 %r Scale 304472807 ¥ | @@ Magnifier | 100% s

Docked attribute tables (left: country borders, right: UN data)

The next step is to prepare the join of the two tables. Therefore, you have to find a column with identical values
for each of the countries. The names are not so well suited in this case, because they are written in a different
manner (Viet Nam and Vietnam). To avoid this, the column with the ISO 3166-1 values is ideal. The column is
named geoAreaCode (UN dataset) and ISO_N3 (countries).

ne_50m_admin_0_countries :: Features Total: 241, Filtered: 241, Selected: 0 @ 721cleanedCSV :: Features Total: 273, Filtered: 273, Selected: 0 @@
2] & LT B %L » E R - - e B =&
POP_RANK GDP_MD_EST POP_YEAR INCOME_GRP Key.ix-: _N3 = SeriesDescr \,,I(erv GeoAreaCode GeoAreaName Value_2000 Value_2001 Value_20 =
1 5129 14 20880,00 2017 5. Low income 728 1 | Renewable ener... 234 Faroe Islands 2,74 2,53
2 D000 12 12250,00 2013 4. Lower middl... 706 2 |Renewable ener... 662 Saint Lucia 2,62 23
3 1024 13 101800,00 2017 3. Upper middl... 688 3 |Renewable ener... 398 Kazakhstan 25 244
4 5935 15 176300,00 2017 4. Lower middl... 729 4 Renewable ener... 776 Tonga 248 27
5 1386 13 4719,00 2017 5. Low income 706 5 |Renewable ener... 348 Hungary 517 512
6 2452 16 2788000,00 2017 1. Highincome... 826 6 | Renewable ener... 380 Italy 512 538
7 2083 7 365,80 2017 2. Highincome... 534 7 |Renewable ener... 135 Caucasusand... 5,02 483

Common key: right geoAreaCode, left ISO_N3_L
Joining two tables

It is important to know that the code is formatted in a different datatype (Long vs String). But in comparison to
ArcGIS, this is no problem in QGIS. You are able to join datasets also with a different datatype. To do so, you
have to click with the right mouse button on the countries layer and select Properties => Joins (1.) => +-Symbol
(2.). Then select the SDG dataset (3.), the join column (GeoAreaCode; 4.) and the right column from the coun-
tries (ISO_N3; 5.). After this click OK (6.) and apply (7.) the join.
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etti Value
> Join layer 721cleanedCSV

N

@ Edit Vector Join x
Jon layer 3. £21 721eanedcsy
" B e
Tagetes 5. |
W Cache jom layer n vrtual memary
Oymamic form
> Edpble onlaver
W JonedFields
»
6- X Cancel
7.
Style =3 Cancel App Help.
Join
Set CRS »
Layers Export » Save Features As...
« (il ® T &~ 5l Styles » Save Selected Features As...
= 721cleanedCSV Properties... Save as Layer Definition File...
£ pe S0m admin O countrics Save as QGIS Layer Style File...
(2 Save Vector Layer as... x
Format ESRI Shapefile -
Fiename |C:\0SGeo4W64\bin\nationen.shp| €
Layer name
CRS EPSG:4326 - WGS 84 v —:‘-_
a
Encoding UTF-8 -
Save only selected features
P Select fields to export and their export options
w Geometry
Geometry type Automatic v
Force multi-type
Indude z-dimension
> Extent (current: layer)
w Layer Options
RESIZE | NO .
SHPT -
w Custom Options
Data source
Layer -
V| Add saved file to map OK Cancel Help

Make the join permanent
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If you sort the resulting table the value_2000 field ascending, you can see that some fields are filled with <NULL>\
These are the countries without any data.

Now we are creating a copy of the countries dataset to make the join permanent. To do so, right click on the
layer, Export => Save features as. The name of the dataset should be “nations”. After the export, our copied layer
is also visible in the layer manager.

Now we are able to calculate trends in the usage of renewable energy in the timeframe from 2000 to 2016. There-
fore, we have to add a new field where the difference is calculated. First open the attribute table of our new nations
layer and click deselect all. Then open the field calculator, insert a short name for the new field (DO0_16), set
decimal number (real) as datatype with precision 8 and scale 2. Now you can substract the values of 2000 from the
values of 2016.

Q@ Field Calculator ”

1. V| createaneweld Update existing field

Create virtual field

2.0
3.0
4, ou

Expression | Function Editor

B E R RS LS group field
: abe T2cleanedCSV_GeoAreaNa.. =
1.2 T21cleanedCSV_Value_2000
5, 1.2 T21cleanedCSV_Value 2001
1.2 T21cleanedCSV_Value_2002

Double-click to add field name to expression string.
Right-Click on field ntext menu sample value loading options

1.2 721cleanedCSV_Value_2003 Loading field values from WFS layers isn't supported, before the layer is actually
1.2 T21cleanedCSV_Value_2004 inserted, ie, when building queries.
1.2 T21cleanedCSV_Value_2005
1.2 T21cleanedCSV_Value 2006 Values
1.2 T21cleanedCSV_Value 2007
1.2 721cleanedCSV_Value_2003
1.2 T21cleanedCSV_Value 2009
1.2 T21cleanedCSV_Value_2010
1.2 T21cleanedCSV_Value 2011
1.2 T21cleanedCSV_Value 2012
1.2 T21cleanedCSV_Value_2013
1.2 T21cleanedCSV_Value 2014
1.2 T21cleanedCSV_Value 2013
Output preview: AULL 1.2 T21cleanedCSV Value 2016~

AllUnique 10 Sampies

6 oK Cancel Help

Calculate the difference

If you sort the new column ascending, the differences in the development of renewable energy get visible. Equa-
torial Guinea has in 2016 37% less, Liechtenstein 63% more energy share from renewable ressources. Many
countries don't have any big differences. We make a short discussion of the data later on.

Visualization

Problem Data Data pre-

Interpreta-

Modeling tion

statement search paration

To create an attractive printable map for your final report that follows the rules of cartography, it is advisable to
consult the tutorial on cartography!? with common statements on maps. If you are not yet familiar with creating
thematic maps, please read our tutorial on map design.

Again we will show you a solution with ArcGIS and one with QGIS.
with ArcMap

The layer can now be categorized and colored again in symbology according to a meaningful scheme. For this
we select a quantitative highlighting under Properties (Symbology => Quantities => Graduated Colors), take e.g.
6 classes (plus one class for the former <NULL>-values) and select a traffic light coloring for the representation.
Red should represent a decrease, green an increase of renewable energies.

13 https://learn.opengeoedu.de/tutorials#tutorial-kartographie
14 https://learn.opengeoedu.de/tutorials/OGE-Tutorial_Kartengestaltung-en.pdf
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Layer Properties
General Source Selection Display Symbology  Fields  Definition Query  Labels  Joins & Relates Time  HTML Popup
Show:
Feat Draw quantities using color to show values. Impart...
Categories Fields Classification
Quantities Value: | 2005_2015 v | Manual
i Graduated colors :
Graduated symbols MNormalization: |n|:|ne Classes: & Classify ..
Proportional symbaols
i Dat density Colar Ramp: ‘-
Charts
Multiple Attributes Symbol  Range Label
EEEEd99--30 No Data
P 2s--16 -25--16
-15-4 -15-4
-3-4 -3-4
5-20 5-20
2 -63 21-63
[] Show class ranges using featurs values Advanced -
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Color coding
Table Of Contents Ix P o il o
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[ No Data
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Visualization by countries
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Veranderung des Anteils erneuerbarer Energien am Gesamtstrombedarf
im Zeitraum 2005 bis 2015 in Prozentpunkten.

R Ay e R AT
N R e IR R ERET
e AT el e S S5
R R I RT S, % KK, eTetelelels >,
S5, == Tt T Tt e s Tt
RS T esiesilelieliieieiete ittt ettt
SR Bt by et %% WSttt o2,
Kilometers Anderung in Prozentpunkten
0 2.500 5.000 10.000 15.000 e
B woata [ 1-2
Mafstab: 1:140.000.000 - -28--16 |:| 4-22
Bearbeiter. Alexander Steiger
Erstellungsdatum: August 2018 |:|'15"3 l:l 23-83
Quellen: ArcGIS online, UN sustainable development goals l:l 2.0
Map layout

To create a diagram for the development of renewable energies over time, select a country, copy the
EG_FEC_RNEW value for the last 16 years and display it in a diagram (here with Excel) The result for Germany
then looks something like this: A clear increase in renewable energies over the last 15 years.

Value Year
3,70 2000
3,90 2001
441 2002 Renewable energy sharein the total final energy
%06 2003 consumption (%) - Germany
£ 83 2004
6,76 005 .
775 2006 ’
941 007 .
3,5‘.:.1 008 2010 . .
9,63 2000 2008 .
10,29 W0 o . ’
11,39 0 , "
12,02 2012 ’
12,09 013 0
13,38 2014 2000
14,21 015 3,00 5,00 700 o 00 1100 13,00 1500

Time serie as chart
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with QGIS

The layer can now be categorized and colored using the style management (Layer Properties => Style) according
to a meaningful scheme. For this we select a quantitative highlighting under Properties (Symbology => Quantities
-= Graduated Colors), take e.g. 5 classes (plus one class for the NULL values) and select a traffic light coloring
for the representation. Red should represent a decrease, green an increase of renewable energies. The class
boundaries as well as the entries for the legend can be changed manually by double-clicking on the respective
values.

This will be demonstrated step by step using the year 2000. For the symbolisation, the column Value_2000 is
selected using an expression (case when "721clean_6" IS NULL then -99 else "721clean_6" end) (1.). The expres-
sion sets all <NULL> values as -99 and thus recognizes them as data gaps.

They are then classified as a green gradient (2.) in 6 classes (3.) (4.). The class limits are defined manually (5.) by
entering values (6.) (7.). The labels are adjusted (8.) and finally the selected setting is executed (9).

() Layer Properties - nationen | Symbology X

.Change A

Legend format | %1 - %2 Precision0 |¥| | | Trim

d Symbology

€ Labels & hor o

thod Color *

M Diagrams

Ng 3D View

E Source Fields
=] -
Attributes Form

Joins

ﬂ Auxiliary Storage
B scton

, Display

& Rendering

Variables

E Metadata
ﬁ Dependencies

.
= Legend

-

] QGIS Server

u Digitizing

Mode | Equal Interval v 3. Classes |6
> Symmetric Classification
Classify &h| | = Delete All Advanced ~

v Link class boundaries

P Layer Rendering

Style ¥ oK Cancel ¥ Apply Help

Color settings Value_2000

The result is the following view for the year 2000, in which on the one hand the countries without data (in black,
from Antarctica to Taiwan) are well recognizable. On the other hand, the proportion of renewable energy used in
2000 can be differentiated to some extent on the basis of green tones.
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View Value_2000

We save the selected color scheme by right-clicking on Nations => Export => Save as QGIS Layer Style File in the
editing folder.

Set Layer Scale Visibility...
Set CRS »

(Al

Save Features As...

Layers

*c" l:@ ®- 7 8.‘ L 4
= 721cleanedCSV

Styles » ‘ Save Selected Features As...

Save as Layer Definition File...

Save as QGIS Layer Style File...

Properties...

P nationen

v No Data |
vi| |o

v ] >0-10

v >10-20

v »>20-50

v >50-100

Save color settings
We then proceed in the same way for the values of 2016. However, in QGIS it is not possible to load the represen-
tation directly in the concrete case, since the select statement must be adapted accordingly (case when
"721clean22" IS NULL then -99 else "721clean22" end).

In this case the classes are reset again. Consequently they have to be adjusted manually again. Nevertheless,
styles can also be loaded and applied.
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o Losd style from fie =
Column case when “72Ickan 6 IS NULL the rs
¥ &% Layer Configuration
Symbol
v & Symbology
Legend format | %1 - %2
v @ 30 symbolo
Color ¥ 9y
€ Labels = Categories v @b Labels
T Diagrams Hetogram V! [ 5] Fields
=l
Symbol * Values Legend v 25| Forms
v [l -92.00--001 NeData 7 8 Actions
&2
elds vi[] -001-000 0 -
vl  000-1000 »>0-10
& Forin v/l 1000-2000 >10-20
v/l 2000-5000 >20-5
v/l  50.00-10000 >50- 100
z‘-s ettermannDesktop\Prospera\Daten\GeodatenOSM_Verkehr\sdg_2000.qml
]
L
4' Load Style Cancel Help
G Select afile .
4 > ThisPC > Desktop > Prospero > Daten » Geodaten » OSM Verkehr v & | Search OSM Verkehr »
Organise *  New folder e o @
Save Style... ame Date modified
* Quick scce:
Save a5 Default ] 3 s
2o T :
Restore Defauit ey i, s 2008
e & Downloads
Add...
&= Pictures *
Rename Current...
[ Desktop

ne_50m_admin_0_c

DG

Apply color settings for other data set

View Value_2016

In the year 2016, the darker shades of green in Europe in particular will indicate the higher use of renewable
energies.

In order to emphasize this difference visually, we create a visualization in traffic light colors. Red should represent
a decrease, green an increase of renewable energies. Since the difference between the countries without data
would be 0 and therefore not distinguishable from countries with data that have not changed, we use a trick. We
create a new copy of the shape file (see above) of the nation dataset, named NationBackground.shp. Now we color
it so that all countries with -99 are colored black and all other countries are transparent. Now you can see the
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Antarctica and other countries without data in black and unfilled countries like South Sudan or Oman, which hh
provided data only in the course of time.
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Background map
Now we go analogous to the single years to the coloring of the difference data and evaluate the field DOO_16. The
sequence corresponds to the previous one, only a color gradation from red to green in 7 classes is selected, the
limits are set manually [<-20, -10, -1, 1, 10, 20, > 20]. It is essential that the borders of the fields are narrower and
grayed out. To do this, all classes are marked and the border line is edited using the button Symbol. In addition, a
meaningful description of the classes is necessary.
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Difference 2016 to 2000 for all countries
The last step is to create a thematic map with QGIS. For a better understanding, you can read the online tutorials
about Cartography and Thematic Mapping.
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Thematic map production

In order to create a sophisticated thematic map, a great deal of processing is usually required after the analysis in
order to meet the demands of thematic cartography. We refer here again to the cartographic literature and our
online tutorials on cartography and thematic cartography.

In QGIS, thematic maps are created using the print layout. This can be found under => Project => New print lay-
out. We give the layout the name "SDG 2000 - 2016". Then the area for the map is drawn using the button Add
new map to layout (1.). By clicking on Move content the map can now be moved to the desired position (2.). In
the area Scale on the right side we enter 80.000.000, which corresponds to a scale of 1: 80.000.000, so that the
map can be displayed full page (3.).

A legend window is then added (4.). On the right an area with the legends appears. The heading "Legend" can be
assigned to the legend here (5.). Here you can rename the individual fields accordingly (6.). It is important that
Automatic update is deactivated (7.). Furthermore, unneeded elements, such as the original data table, can be
deleted using the minus button (8.). To display the legend in two columns, we increase the number of columns in
the "Columns" area (9.).

Now we add the necessary map elements like title, scale bar (with kilometre indication), author, sources etc. via
the Add element in the menu bar and get a quite acceptable map design (10.). A special feature is that the north
arrow must be inserted as an image in QGIS.

Note: A scale bar cannot be added in QGIS for world maps because of their projection properties. You are only
able to add a scale bar for maps with an aquidistant projection. In this case, the values of the scale bar screwed
up so we don’t draw it on the map.
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QGIS print layout
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Final map

Evaluation and visualization of time series
with Excel or LibreCalc

Now we return to the Excel or Libre Calc evaluation in order to analyse selected statistical measures as well as
the temporal progressions. First we create a copy of the prepared data set, e.g. as a second table in the Excel
file.

Measurements

First we eliminate all countries without data (-99) by sorting Value_2000 in ascending order and then manually
deleting the rows with -99 completely (from the Aland Islands to Western Sahara). At the end of the table we add
three new lines with the respective entries "Minimum worldwide", "Average worldwide" and "Maximum worldwide"
to the place of the country names. We then calculate the values for Value_2000 at the respective position using
the function "=Min(F2:F228)", "=MEDIUM VALUE(F2:F228)" and "=Max(F2:F228)". We then drag these functions
in the row/column up to Value_2016. Then we format them as a number with 2 decimal places.

The interpretation of the very different results for the individual countries is done later.
Time diagrams

To create a diagram for the development of renewable energy over time, we create another table, copy the head-
ings of the old table and the rows of the calculated values Minimum, Average and Maximum as numerical values
into the table. Then we search for the desired 6 countries (Algeria, Australia, Costa Rica, Ecuador, Germany and
Viet Nam) and copy their data into the new table. Delete the first 4 columns (from goal to geoArea code) to make
diagram evaluations easier. The result looks like this.

geoAreaName value_2000 value_2001 value_2002 value_2003 value_2004 value_2005 value_2006 value_2007 value_2008 value_2009 value_2010 value_2011 value_2012 value_2013 value_2014 value_2015 value_2016

Minimum worldwide 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00 0,00
Average worldwide 15,17 14,73 14,82 15,21 15,60 14,95 15,50 15,72 15,50 16,71 16,91 16,86 17,00 17,53 17,24 17,16 17,21
Maximum worldwide 93,91 96,23 96,16 97,02 97,27 97,29 96,86 96,89 96,85 96,92 95,28 93,80 93,89 94,39 94,58 94,44 94,67
Algeria 0,43 0,43 0,51 0,47 0,44 0,58 0,41 0,41 03 0,31 0,26 0,18 0,18 0,13 0,07 0,06 0,08
Australia 8,42 8,37 8,74 7,15 6,68 6,71 6,85 6,95 6,79 7,11 8,13 8,31 8,29 9,09 9,22 9,16 9,32
Costa Rica 32,95 32,11 32,65 33,66 39,5 42,06 42,27 42,84 43,13 42,27 42,31 40,5 38,62 38,29 38,05 38,93 37,16
Ecuador 20,03 18,43 18,06 17,97 15,97 12,16 12,97 12,81 15,09 133 12,11 13,65 13,38 12,94 12,48 14,13 15,18
Germany 3,7 3,9 4,41 5,06 5,83 6,76 7,75 9,41 8,59 9,63 10,29 11,39 12,01 12,09 13,38 14,21 14,17
Viet Nam 57,97 56,36 52,42 51,03 45,99 44,36 44,47 42,11 39,46 37,17 34,8 36,53 38,12 37,71 36,98 34,73 32,71
Country comparison

Select two countries (select line while pressing the CTRL key), here Algeria and Germany and create a line dia-
gram.
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16 Renewable energy share in the total final energy consumption
from 2000til 2016 [%)]
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Comparing Algeria and Germany
Similarly, we create a time diagram for all 6 countries considered in a worldwide comparison.

Renewable energy share in the total final energy
consumption from 2000 til 2016 [%]
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Six countries in comparison to the worldwide situation
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To interpret your results, go back to the pages of the United Nations and read about the significance of the indica-
tor you have chosen.

Interpretation of the example:

In the 7th objective for sustainable development, the UN calls (among other things) for a substantial increase in
the share of renewable energies. According to the UN, the generation of energy from fossil fuels, which is still
dominant today, accounts for 60% of all greenhouse gas emissions and is thus one of the main driving forces be-
hind anthropogenic climate change. The fulfilment of this objective is therefore closely linked to objective 13 - cli-
mate change. On the other hand, renewable energies represent a great opportunity, especially for developing
countries, to become independent of the import of energy (carriers) from abroad or to electrify remote areas in the
first place. Against this background, this paper describes the extent to which the share of renewable energies in
total energy consumption changed per country between 2000 and 2016. The indicator 7.2.1 - Renewable energy
share in the total final energy consumption (%) (indicator EG_FEC_RNEW) of the UN sustainable development
goals was selected for this purpose. This is an estimated value based on national estimates.

European countries have developed almost exclusively positively (cf. the visualizations 2000 to 2016), as have
most developed countries. In the period 2000 to 2016, Germany recorded an almost linear increase in the share
of renewable energies (from 3.7% to 14.2%, see diagram), whereas Algeria recorded a regression.

The general trend in the developing and emerging countries in South America, Africa and Asia is a decline in the
share of renewable energies. However, the development of absolute energy consumption remains unnoticed in
this presentation. In China, for example, primary energy consumption almost doubled between 2005 and 2015
(from 1793 to 3010 million tonnes oil equivalent, i.e. enormous new capacities of renewable energies were built
up during this period to "only" drop 6 percentage points).

Sources

Indicator 7.2.1.: https://unstats.un.org/sdgs/metadata/?Text=&Goal=7&Target=7.2=&Goal=7&Target=7.2

Statistical data: https://de.statista.com/statistik/daten/studie/42182/umfrage/primaerenergieverbrauch-von-china-
in-oelaequivalent/

Country data: https://www.naturalearthdata.com/downloads/50m-cultural-vectors/
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